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Although the information contained within this document are presented in good faith and believed to be correct, Landis+Gyr (including its affiliates, 

agents and employees) disclaim any and all liability for any errors, inaccuracies or incompleteness relating to the product. Landis+Gyr makes no 

warranty, representation or guarantee regarding the performance, quality, durability or suitability of the products for any particular purpose. To the 

fullest extent permitted by law Landis+Gyr disclaims (1) any and all liability arising out of the use of the product, (2) any and all liability, including, but 

without limitation to, special, consequential and indirect damages and losses, and (3) any and all implied warranties, including, but without limitation 

to, fitness for purpose and merchantability. 

The information contained in this document is strictly confidential and is intended for the addressee only. The unauthorised use, disclosure, copying, 

alteration or distribution of this document or the contents thereof is strictly prohibited and may be unlawful. 

All product information are subject to change without notice. 
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Introduction 

 

The present user manual is designed for the Landis+Gyr .MAP120 Parameter 

Editor Release 4.5 and higher.  

 

This user manual contains all information required for the use of the Landis+Gyr 

.MAP120 Parameter Editor. It not only provides explanations concerning function-

ality and general procedures, but also gives detailed, illustrated instructions on 

how to use the software.  

 

The contents of this user manual are intended for technically qualified personnel 

of energy supply companies responsible for system planning, parameter setting 

and installation of devices. 

 

The Landis+Gyr .MAP120 Parameter Editor runs on PCs with Windows operating 

system. To understand this user manual, you need basic knowledge of Windows 

and its terms, as well as a general idea of how to operate a PC. Furthermore, you 

need to be familiar with the functional principles of the various devices supported 

by the Landis+Gyr .MAP120 Parameter Editor, which are described in the corre-

sponding user manuals and functional descriptions. 

 

The following conventions are used in this manual: 

1. 2. 3.  Ordinal numbers are used for individual steps in the instructions.  

Tools Buttons, menu names and individual menu items appear in bold 

text. 

[F1] Keys are shown in square brackets. 

[Ctrl]+[V] Key combinations are shown with a plus sign (e.g. [Ctrl] key kept 

pressed while pressing [V] key) 

"Options" Names of windows and elements appear in quotation marks.  

 

Scope 

Purpose 

Target group 

Conditions 

Conventions 
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1 Overview 

The Landis+Gyr .MAP120 Parameter Editor supports services needed to edit and 

download complete device descriptions (parameterisations) into the supported 

Landis+Gyr devices.  

The following diagram illustrates the various fields of application of the 

Landis+Gyr MAP and .MAP Tools. 

 

1.1 Functions 

The Landis+Gyr .MAP120 Parameter Editor supports the following main use cases:  

1. Creating a device description file for manufacturing and documentation 

purposes 

2. Changing parameters of a connected device (e.g. at utility central services) 
 
The range of functions comprises:  

 Create and edit device descriptions 

 Read complete device descriptions from devices 

 Write complete device descriptions or specific parameter groups (e.g. time of 

use, security system) to devices and execute related actions (e.g. clock setting, 

register reset) 

 Save and open complete device descriptions 

 Print device descriptions 

 Compare two device descriptions 

1.2 Communication channels 

The Landis+Gyr .MAP120 Parameter Editor can communicate with the devices via 

the following communication channels: 

 Serial: Optical reading head, Bluetooth reading head, RS232, RS485, CS, M-Bus  

 Modem: PSTN, GSM  

 Network: GPRS, Ethernet  
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1.3 Communication protocols 

The Landis+Gyr .MAP120 Parameter Editor supports the following communication 

protocols:  

 DLMS / HDLC  

 DLMS / TCP (wrapper) with IPv4 and IPv6 

 DLMS / UDP (wrapper) with IPv4 and IPv6 

 IEC 62056-21 (formerly known as IEC 1107) 

1.4 DLMS security 

The Landis+Gyr .MAP120 Parameter Editor supports the following DLMS security 

features:  

 DLMS access security (low level and high level security)  

 DLMS message security (security suite 0)  

1.5 Editions 

The Landis+Gyr .MAP120 Parameter Editor is only available in a Standard Edition.  

1.6 Supported devices 

Please refer to the read-me file (see section 7.9 "Displaying release notes") for a 

list of supported devices.  
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2 Installation and Uninstallation 

This section describes the installation of the Landis+Gyr .MAP120 Parameter 

Editor on your PC and its uninstallation if it is no longer used.  

2.1 Installation 

 

To be able to run the Landis+Gyr .MAP120 Parameter Editor, your PC must be 

equipped with the operating system Windows 10 or Windows 11.  

For 64 bit operating systems dedicated hardware drivers (e.g. for the optical head 

or other communication equipment) might be needed. Please contact the vendor 

of your devices to obtain a driver update, if necessary.  

Additionally, the following system component, which is not part of the Landis+Gyr 

.MAP120 Parameter Editor, must be installed on your PC: 

 .NET Framework Version 4.6.1 or later 

 

Administrator privileges on your computer are required for the installation and 

the licensing.  

 

The installation software for the Landis+Gyr .MAP120 Parameter Editor can be 

downloaded to your PC via the Internet from the Landis+Gyr homepage 

www.landisgyr.eu. Please contact your sales representative to receive the 

required username and password for the download. 

 

The required language must be selected at installation time. It can be changed 

again at any time in the Landis+Gyr .MAP120 Parameter Editor. 

 

Please read the file "dMAP120_Readme.txt" with current information about the 

present release of the Landis+Gyr .MAP120 Parameter Editor. 

 

Start the installation file "Setup.exe" and then follow the instructions of the setup 

wizard. 

 

Close the Landis+Gyr .MAP120 Parameter Editor, if it is in use. Then start the 

installation file "Setup.exe" and follow the instructions of the setup wizard.  

When upgrading a former release 4.5 to the latest release 4.5, the former release 

will be automatically replaced by the newer one. All data including the license and 

the communication settings is kept. 

When upgrading a former release 2.x, 3.x, 4.0, 4.1, 4.2, 4.3 or 4.4 to the latest 

release 4.5, the new release can be installed in parallel to a former release in a 

separate directory. All data including the license and the communication settings 

is kept. 

Former releases 1.x can't be upgraded.  

Landis+Gyr recommends removing older releases since they will no longer be 

supported.  

System requirements 

Administrator privileges 

Installation software 

Language 

Preparation 

First installation 

Upgrades 
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2.2 Uninstallation 

If the Landis+Gyr .MAP120 Parameter Editor is no longer needed, it should be 

uninstalled.  

To do so, open the Windows Control Panel and use "Uninstall a program" from 

the "Programs" category. 

2.3 Required setting when operating .MAP120 on high resolution displays 

On computers with high resolution displays (e.g. UHD with 3840 x 2160 pixels) or 

in general when using a Windows display scale factor of more than 150% a special 

setting is required to operate the Landis+Gyr .MAP120 Parameter Editor. Without 

this setting the tool will appear very small with a scale factor of 100% and can 

hardly be used. 

The Landis+Gyr .MAP120 Parameter Editor must be started using a link in which 

the "Disable fullscreen optimizations" checkbox is ticked in the "Compatibility" 

tab: 

 

Furthermore the "Override high DPI scaling behaviour." checkbox in the additional 

window which appears after clicking the button Change high DPI settings must be 

ticked: 
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Nevertheless a few icons in the application tool bar still will be shown minimized. 

But this doesn't affect the usability of the Landis+Gyr .MAP120 Parameter Editor. 

It is planned to modify the program so that it will work properly in the future 

without this setting. 
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3 Licensing 

Landis+Gyr provides two different license types. 

 The standard license 

 The user management license 

This section explains the licensing concept and describes the steps necessary for 

licensing the Landis+Gyr .MAP120 Parameter Editor.  

3.1 Concept of the standard license 

After installation, the Landis+Gyr .MAP120 Parameter Editor is in the unlicensed 

state, i.e. it can only be used as demo version with reduced range of functions. In 

order to permit the use of the Landis+Gyr .MAP120 Parameter Editor without 

restrictions, it must be licensed. For this purpose, the following licensing data can 

be obtained from the Landis+Gyr representative responsible, which must be 

entered in the Landis+Gyr .MAP120 Parameter Editor: 

 User Name 

 User Group 

 License Key 
 
The procedure is described in section 3.1.1 "Entering license data".  

 

 MAP120 licence key is not valid for .MAP120 

The license key for the former Landis+Gyr MAP120 Parameter Editor cannot be 

used for the Landis+Gyr .MAP120 Parameter Editor. A new licence key is required. 

 

The license of the Landis+Gyr .MAP120 Parameter Editor release 2.2 or later is 

handled individually per Windows user and per .MAP120 main release on a single 

PC. If several persons share the same PC, the required .MAP120 user group with 

its specific functionality can therefore be individually assigned to each Windows 

user (up to release 2.0 the same license was used for all Windows users of a single 

PC and all .MAP120 releases). 

When upgrading a former .MAP120 release 2.x to release 2.2 or later the current 

license is kept, i.e. it is copied once for each Windows user of the PC from the for-

mer release.  

From release 2.1 any license change or a new license only affects the current Win-

dows user and the current .MAP120 main release.  

The license conditions remain unchanged, i.e. all existing and new licenses can be 

further used by one or several Windows users on one or several PCs. Please note, 

that normally the user name in the .MAP120 licence and the Windows user name 

are different.  

 

3.1.1 Entering license data 

This section describes the licensing procedure required for unrestricted use of the 

Landis+Gyr .MAP120 Parameter Editor. The license data received from Landis+Gyr 

following your order is required for this purpose. 
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 Administrator privileges required 

Administrator privileges on your computer are required for the licensing.  

 

Procedure: 

1. Click on Start and then under All programs select the Landis+Gyr program 

group. 

2. Right click on the Landis+Gyr .MAP120 - 4.5 command and then select the 

entry "Run as administrator" in the popup menu appearing.  

The Landis+Gyr .MAP120 Parameter Editor is started.  

3. Select License from the Tools menu.  

The "License" window appears. 

 

4. Enter the user name provided by Landis+Gyr in the "User Name" entry box.  

5. Select the user group provided by Landis+Gyr in the "User Group" drop down 

list.  

6. Enter the licence key provided by Landis+Gyr in the "License Key" entry box.  

 

7. Click on OK. 

The licence data is checked and a success message is displayed.  

 

8. Click on OK. 

The licensing procedure is terminated.  

The Landis+Gyr .MAP120 Parameter Editor is now ready for use according to the 

instructions given in the following sections.  
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 Keep the license key in a safe place 

Please note that due to security reasons the license key is not shown anymore if 

the "License" window is reopened. Keep the license key in a safe place for further 

use. 

 

3.2 User management license 

In the last few years many utilities have understood that smart metering is a part 

of their smart grid and with this, part of critical infrastructure. Millions of smart 

meters, deployed in every residential home, must be protected against misuse as 

an entry point into the utility IT network. This triggers increased security at smart 

meters and also at any field tools and in particular the Landis+Gyr dMAP tools. 

Our dMAP tools (dMAP120 ver. 4.14.x and later) with the new user management 

address these needs. With the user management license, dMAP Tool Users must 

authenticate themselves when using the dMAP tools by entering their username 

and password. For each dMAP Tool User, the dMAP transmits a pre-defined user 

ID to the linked meter. The meter then stores this user ID, allowing utilities to 

identify the tool user who communicated with a meter and to some extent the 

changes made to the meter parametrisation. 

For maximum security, it is even possible to “dongle” a Tool User to one specific 

PC. If activated, the dMAP tool traces the login data of the Tool User and 

transmits it to a SFTP server. 

Detailed information is described in an additional user manual, which will be 

provided with the user management license. Please get in touch with your 

Landis+Gyr representative for a commercial offer on this new functionality. 

 

 

 

 

 

 

 

 

 

 

 

 

Smart Meter 

 

Records the Tool 

User ID  

(submitted with 

every dlms pdu) 

Tool User 1 

with User ID 1 

 

Tool User 2 

with User ID 2 

 

Tool User logs on 

to the dMAP tool 

using his 

credentials 

dMAP Tool 

dMAP Tool dMAP Tool 

communicates with 

the meter using the 

Tool User’s User ID 2 

Tool User logs on 

to the dMAP tool 

using his 

credentials 

dMAP Tool 

communicates with 

the meter using the 

Tool User’s User ID 1 
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4 Description of user interface and general functions 

This section describes the user interface of the Landis+Gyr .MAP120 Parameter 

Editor and contains procedures to use its functions.  

4.1 Overview 

The user interface of the Landis+Gyr .MAP120 Parameter Editor comprises the 

following areas:  

 Menu bar (1) with menus to select functions. 

 Toolbars (2): 

– Application toolbar 

– Access level toolbar 

– Address toolbar (either phone number or IP address is visible) 

– Device toolbar 

– Communication channel toolbar 

 Device description window: 

– Tree view of device description (3) 

– Detail view of device description (4) 

– Status bar of device description (5) 

 Communication log (6) for recording and analysing communication activities 

 Status bar (7) for displaying data about the current communication status. 
 

 
 
The sizes of the areas for the tree view, detail view and communication log can be 

set individually with the movable separators situated in between (click separator 

and move with mouse button pressed). 

 










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The status bar and the communication log can be faded in or out using the corre-

sponding menu points of the "View" or "Communication" menu. 

4.2 Menu bar 

The menu bar of the Landis+Gyr .MAP120 Parameter Editor contains the following 

menus for selecting functions: 

 

Menu Menu entry Description of function 

File New… See section 5.1.1 "Creating new device descriptions" 

 Open… See section 5.1.2 "Opening existing device descriptions" 

 Save See section 5.1.3 "Saving device descriptions" 

 Save as… See section 5.1.4 "Saving device descriptions under a 

new name" 

 Close Closes the active device description window 

 New from OMT file… For LG internal purposes only 

 Change firmware 

version… 

For LG internal purposes only 

 Print page setup… See section 5.1.5 "Defining the print layout for device 

descriptions" 

 Print… See section 5.1.7 "Printing device descriptions" 

 Print preview See section 5.1.8 "Previewing the printout on the 

screen" 

 Exit Terminates the Landis+Gyr .MAP120 application 

View Compare to file… See section 5.1.11 "Comparing a device description to a 

file" 

 Compare page 

setup… 

See section 5.1.6 "Defining the print layout for compare 

results" 

 Status bar See section 5.1.9 "Switching the status bar on and off" 

Communication Connect Dials the selected phone number to establish a modem 

connection 

 Disconnect Terminates an existing modem connection 

 Load from device See section 5.1.10 "Reading device descriptions from a 

device" 

 Send to device See section 5.3.2 "Starting the parameterisation wizard" 

 Abort Interrupts the existing communication session 

 Communication 

settings… 

See section 6.2 "Communication settings" 

 Communication log See section 4.5 "Communication log" 

Tools ASCII character 

converter… 

See section 7.1 "Converting ASCII to text or vice versa" 

 Licence… See section 3.1.1 "Entering license data" 

 Startup language… See section 7.2 "Changing the language of the user 

interface" 

 Options… See section 7.5 "Defining storage location of 

communication settings" 
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Menu Menu entry Description of function 

Windows Cascade Arranges windows in an overlapped fashion 

 Tile vertical Arranges windows in non-overlapped vertical tiles 

 Tile horizontal Arranges windows in non-overlapped horizontal tiles 

 Close all Closes all open device description windows 

Help Help See section 7.8 "Displaying tool help" 

 Release notes See section 7.9 "Displaying release notes" 

 About .MAP120… See section 7.10 "Displaying the current program 

release and checking for updates" 

 

4.3 Toolbars 

4.3.1 Application toolbar 

 

The application toolbar contains the following buttons for direct selection of 

frequently required functions: 

  
Creates a new device description  

(see section 5.1.1 "Creating new device descriptions") 

  
Opens a stored device description file  

(see section 5.1.2 "Opening existing device descriptions") 

  
Saves the selected device description file  

(see section 5.1.3 "Saving device descriptions") 

  Prints the selected device description 

(see section 5.1.7 "Printing device descriptions") 

  Displays a print preview of the selected device description 

(see section 5.1.8 "Previewing the printout on the screen") 

  
Displays the communication settings window 

(see section 6.2 "Communication settings") 

  
Fades the command log in or out 

(see section 4.5 "Communication log") 

  
Loads the device description (all parameters) from the device 

(see section 5.1.10 "Reading device descriptions from a device") 

  
Starts the parameter wizard  

(see section 5.3.2 "Starting the parameterisation wizard") 

  
Interrupts the existing communication session 

 

Buttons which are not applicable in a specific situation are disabled and shown in 

grey.  
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4.3.2 Client toolbar 

 

The access level toolbar allows selection of the required access level. Only fully 

defined access levels are displayed, a level can occur more than once with differ-

ent settings for different devices.  

Clicking on  in the access level toolbar displays the access level settings (see 

section 6.2.3.3 "Access levels"). 

4.3.3 Address toolbar 

The phone number or IP address drop down lists displayed depending on the 

communication settings allow selection of the corresponding entry in the address 

book. 

 

 

The phone number of the required modem can be selected in the "Phone" drop 

down list if a modem is selected as communication channel.  

Clicking on  in the address toolbar makes the connection to the selected 

phone number. When the connection is made, the drop down list is blocked and 

the icon on the button changes its appearance. 

Clicking on  in the address toolbar terminates the modem connection.  

 

 

The IP address and port number of the required device can be selected in the "IP 

Address" drop down list, provided a network card is selected as interface in the 

communication profile settings. The phone Icon is deactivated. 

Clicking on  in the address toolbar displays the selected address book entry. 

Clicking on  in the address toolbar displays the address book (see section 

6.2.4 "Address data"). 

4.3.4 Device toolbar 

 

The device toolbar allows the selection of devices with predefined settings (device 

series and device addresses). 

With the checkbox "IEC;HDLC" you can deactivate and again activate the device 

address and in the drop down list you can select all defined device addresses.  

 

Clicking on  in the device toolbar displays the device settings (see section 

6.2.3 "Device data"). 
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4.3.5 Communication channel toolbar 

 

The communication channel toolbar allows the selection of communication chan-

nels with predefined settings (e.g. interface, transmission protocols etc.). 

Clicking on  in the communication channel toolbar displays the channel set-

tings (see section 6.2.2 "Communication channel data"). 

4.4 Device description window 

The device description window shows the parameters of a device. Normally it is 

shown maximised, i.e. it uses the entire space in the .MAP120 Parameter Editor.  

 

Clicking the  button in the upper right corner of the .MAP120 downsizes the 

device description window, so that more than one device description window can 

be displayed at once. Using the entries "Cascade" or "Tile" from the "Windows" 

menu allows automatic arrangement of windows.  
 

 
 

1  Toolbar of tree view 

2  Tree view 

3  Movable separator 

4  Toolbar of detail view 












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5  Detail view (detailed view of selected tree items) 

6  Status bar of device description 

 

Device description windows are divided into two by a movable separator (can be 

moved by clicking and shifting the separator). The tree view on the left side of the 

window contains a general tree representation, while the detail view on the right 

side displays details of the currently selected tree item (parameter or folder).  

Both sectors of the window have horizontal and/or vertical picture scrolling func-

tions if part of the window half cannot be seen. Scrolling does not affect the focus.  

Clicking the  button in the upper right corner of a downsized device descrip-

tion window maximises the device description window again.  

 

The toolbar of the tree view contains the following elements: 

 
Displays the online help for the device displayed in the tree  

(details see below under "Displaying device help") 

 
Zooms the content of both sectors of the device description window 

in a range from 1.00 to 3.00 in steps of 0.20:  

 Fully left = magnification factor 1.00, i.e. original size  

 Fully right = magnification factor 3.00, i.e. 3 times bigger size 

 
Allows a full text search in the tree (details see below under "Full text 

search in tree view") 

 
Expands all folders of the tree 

 
Collapses all folders of the tree 

 

A tree view, e.g. as generally familiar from the file system tree of Windows 

Explorer, is ideally suited for navigating in ordered structures with folders and 

subfolders.  

 
 

Tree view toolbar 

Tree view 
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For the Landis+Gyr .MAP120 Parameter Editor the tree consists of a hierarchical 

arrangement of tree items (folders and parameters).  

Tree items are shown as follows:  

 Folder 

 Configuration parameters 

  Network parameters 

  Clock parameters 

 Time of use parameters 

  Communication parameters 

  Other parameters 

 

Each folder can be expanded and collapsed individually.  

Collapsed folder items are preceded by an expansion icon , expanded folder 

items by a collapse icon .  

To expand or collapse individual folders there are the following possibilities:  

Using the mouse: 

 Clicking on the expansion icon  of a folder expands this folder  

(the expansion icon  changes to a collapse icon ).  

 Clicking on the collapse icon  of a folder collapses this folder  

(the collapse icon  changes to an expansion icon ). 

 Double-clicking on a closed folder icon  or on the folder name behind the 

icon expands or collapses this folder. 

Using the keyboard: 

 Pressing the [*] key of the numerical keyboard expands the whole tree of the 

selected folder (i.e. subfolders in the folder will also be expanded).  

 Pressing the [+] key of the numerical keyboard expands the selected folder, 

but doesn't expand its subfolders.  

 Pressing the [–] key of the numerical keyboard collapses the selected open 

folder or the next higher folder if a closed folder was selected.  

Using the buttons in the tree view toolbar: 

 Clicking on  expands all folders of the tree.  

 Clicking on  collapses all folders of the tree.  

 

Tree items 

Folder handling 
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Details of the selected parameter in the tree are displayed in the right-hand part 

of the device description window where the parameters can be edited in the 

corresponding fields.  

 
 

The toolbar of the detail view contains the folder up button . Clicking on this 

button selects the next higher folder above the currently selected tree item. 

 

The status bar below the device description displays the following device descrip-

tion values:  

 Device Description ID 

 Firmware Version 

 Parameterisation ID 

 Type Designation 

 

Note: In newly created device descriptions the Device Description ID and the Para-

meterisation ID are still undefined.  

 

Clicking on  in the toolbar of the tree view of the device description window 

displays the online help for the opened device description. These help texts corre-

spond to the contents of the device functional description.  

Find the desired information. Since the help function is a standard Windows func-

tion, it will not be explained at this point. More details are found in the Windows 

manual belonging to your PC.  

 

Detail view of device 

description 

Detail view toolbar 

Device description status 

bar 

Displaying device help 
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With the search function you can perform a full text search in the tree view of the 

device description window (Note: The detail view of the device description window 

is not included in the search).  

Procedure: 

1. Click on  in the tree view toolbar.  

The "Find .MAP120" window appears.  

 

2. Enter the term you want to find in the entry box.  

If you have already carried out searches previously, you can click on the 

arrow behind the entry box and select one of the previous terms in the 

appearing list. The terms remain in the list until the program is terminated.  

3. Deactivate the check box "ignore case" if the search shall be case sensitive. 

4. In the selection field select  

– containing to search for the term at any place within the tree text, 

– starting with to search for the term at the beginning of the text or 

– ending with to search for the term at the end of the text. 

5. Click on "Find". 

The search result is listed in the "Results" area. 

In the example shown with the term "time" and the attributes "containing" 

and "ignore case" all folders and elements containing the term "Time" are 

listed.  

Note that the whole text is considered, including the item number. Therefore 

a search for "time" with attribute "starting with" would not show any result, 

whereas a search for "time" with attribute "ending with" would show for 

instance the element "10240: Billing Period Reset Lockout Time" since here 

the term "Time" appears at the end of the text. 

Full text search in 

tree view 
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6. Click on a result line in the list to highlight the corresponding folder or 

element in the tree (the folder containing the element is automatically 

expanded).  
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4.5 Communication log 

 

 Additional knowledge required 

Additional knowledge is required to analyse communication activities.  

 

Clicking on  in the application toolbar shows or hides the communication log, 

where all communication activities can be traced and analysed.  

First, the trace level has to be adjusted for each trace type supported as follows:  

1. Click on  in the communication log toolbar.  

The ".MAP120 - Communication Tracers" window appears.  

 

2. Select in the "COSEM Trace" drop down list whether the COSEM Trace shall be 

on or off. 

3. Select in the other drop down lists the resolution of the DLMS, GATEWAY, LCC, 

WRAPPER, HDLC and IEC tracers (low, medium, high) or switch them off. 

4. Click on OK. 

All communication activities are traced in the communication log according to the 

settings made.  

 

To analyse a specific string, mark it and click on  in the communication log 

toolbar. This opens the ".MAP120 - Protocol Analyzer" window.  
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Clicking on  in the communication log toolbar opens the "Open Communica-

tion Log" dialogue window to display logs previously saved again. Clicking the 

right mouse button in the communication log followed by selection of the Open 

Log File menu item in the pop-up menu appearing has the same effect. 

Clicking on  in the communication log toolbar opens the "Save as" dialogue 

window to save the log displayed in a freely selected directory either as RTF file 

(default) or as text file. Clicking the right mouse button in the communication log 

followed by selection of the Save as menu item in the pop-up menu appearing has 

the same effect. 

Clicking on  in the communication log toolbar copies the content of the com-

munication log to the Windows clipboard, from where it can be inserted into an-

other application (e.g. in a word processing program). Clicking the right mouse 

button in the command log followed by selection of the Copy all menu item in the 

pop-up menu appearing has the same effect. 

Clicking on  in the communication log toolbar deletes the communication log. 

Clicking the right mouse button in the communication log followed by selection of 

the Clear menu item in the pop-up menu appearing has the same effect. 
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With the search function you can perform a full text search in the communication 

log window.  

Enter the term you want to find in the entry box of the toolbar (the search is not 

case sensitive) and then click on  or  for searching downwards or upwards 

starting from the currently marked position in the communication log window. 

The first occurrence of the searched term is highlighted.  

Example: Searching the term "auth" finds as first occurrence the DLMS entry "set 

State: AUTHENTICATION".  

 
 

Clicking again on  or  searches for further occurrences of the term. 

4.6 Status bar 

 

The following data is normally displayed in the status bar: 

 Session information, e.g. connected, busy or disconnected 

 Protocol, port and transmission rate (in parentheses) 

 Number of objects sent (blue) and received (green) 

 Data indication (running from left to right while data is transmitted) 

 

 

During and after editing communication settings the status bar shows information 

about the communication settings, e.g.  

 loading (while loading) 

 loaded (while the communication settings are displayed for editing) 

 saving (while saving) 

 saved (after editing the communication settings) 

 

Full text search 
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5 Device description functions 

The Landis+Gyr .MAP120 Parameter Editor is used to edit and download complete 

device descriptions (parameterisations) into supported Landis+Gyr devices. 

5.1 General functions 

This section describes general functions selectable in the menus of the menu bar 

(see section 4.2 "Menu bar").  

5.1.1 Creating new device descriptions 

New device descriptions can be created for any supported device firmware ver-

sion from templates available in the .MAP120 application.  

Procedure: 

1. Click on  in the application toolbar or select New from the File menu.  

The "New Device Description" window appears. 

2. Select the device series, the type and the firmware version.  

 

3. Click on OK.  

The selected device description is created and loaded into the .MAP120 

Parameter Editor.  

During this operation, an indication in the device description window informs 

about the step in progress, e.g. "Loading tree". 
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Afterwards, the selected device description is displayed in the .MAP120 Para-

meter Editor.  

 

4. Perform the intended work with the device description: You can edit the 

parameters of the device description (see section 5.2 "Editing parameters"), 

save it (see section 5.1.3 "Saving device descriptions") or write it into a de-

vice (see section 5.3.1 "Parameterisation wizard").  



30/132      Device description functions 

© Landis+Gyr D000043592 en AB – .MAP120 – Parameter editor – User manual 

5.1.2 Opening existing device descriptions 

Existing device descriptions can be opened in the .MAP120 Parameter Editor. 

Procedure: 

1. Click on  in the application toolbar or select Open from the File menu.  

The "Open" window appears (this is an operating system dialog window and 

therefore the dialog language depends on the version of your Windows user 

interface).  

 

2. Select your personal data folder in the displayed tree structure if it is not 

already displayed.  

3. Double-click on the desired entry in the list or select it and then click on Open.  

The selected device description will be loaded and displayed.  

It is also possible to select a recently opened device description from the MRU 

(most recently used) list in the File menu. This list contains as maximum the 

last 6 opened file names. Clicking on a list entry opens the corresponding 

device description directly.  

 

The device description just opened becomes the active window.  
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4. Perform the intended work with the device description: You can edit the 

parameters of the device description (see section 5.2 "Editing parameters"), 

save it (see section 5.1.3 "Saving device descriptions") or write it into a de-

vice (see section 5.3.1 "Parameterisation wizard").  

5.1.3 Saving device descriptions 

Complete device descriptions can be saved in device description files under the 

original name. If the device description was newly created or is to be saved under 

a new name, you have to proceed as described in section 5.1.4 "Saving device 

descriptions under a new name".  

Procedure: 

1. Activate the window with the device description to be saved.  

2. Click on  in the application toolbar or select Save from the File menu.  

If the device description was modified since it was last saved (recognisable 

by the asterisk in the title bar) the modified data will overwrite the previ-

ously stored data without any warning.  

If the device description was not modified (no asterisk in the title bar) it will 

not be saved again.  

If a new device description has not yet been saved, it will be saved using the 

"Save As" function described in the next section.  
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5.1.4 Saving device descriptions under a new name 

Complete device descriptions can be saved under a new name.  

Procedure: 

1. Activate the window with the device description to be saved under a new 

name.  

2. Select Save As from the File menu.  

The "Save as" window appears (this is an operating system dialog window 

and therefore the dialog language depends on the version of your Windows 

user interface).  

3. Select the desired data folder in the displayed tree structure if it is not 

already displayed. 

A list of all stored device description files of the same type will be shown.  

 

4. Enter the desired name for the device description in the entry box "File 

name".  

If the device description was newly created, the proposed name corresponds 

to the connected device. Otherwise the name formerly used is proposed. 

You can overwrite this proposal.  

5. Click on Save. 

The device description will be saved. The device description name in the title 

bar changes according to the selected name. 
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5.1.5 Defining the print layout for device descriptions 

The "Print page setup" function allows you to determine the desired page layout 

for printouts of a device description.  

Procedure: 

1. Select Print page setup from the File menu.  

The "Page Setup" window appears (this is an operating system dialog win-

dow and therefore the dialog language depends on the version of your Win-

dows user interface).  

 

2. Make the required settings.  

3. Click on OK. 

This terminates the page setup for printing. You can now perform a print 

preview on the screen (see section 5.1.8 "Previewing the printout on the 

screen") or start the printout directly (see section 5.1.7 "Printing device 

descriptions").  
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5.1.6 Defining the print layout for compare results 

The "Compare page setup" function allows you to determine the desired page 

layout for printouts of the compare results.  

Procedure: 

1. Select Compare page setup from the View menu.  

The "Page Setup" window appears (this is an operating system dialog win-

dow and therefore the dialog language depends on the version of your Win-

dows user interface).  

 

2. Make the required settings.  

3. Click on OK. 

This terminates the page setup for compare results. You can now display a 

compare preview on the screen (see section 5.1.11 "Comparing a device 

description to a file") and start the printout directly from there. 
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5.1.7 Printing device descriptions 

The "Print" function prints out the device description in the predefined form (see 

section 5.1.5 "Defining the print layout for device descriptions").  

Procedure: 

1. Activate the device description window you want to print.  

 

2. Select Print from the File menu.  

The "Print" window appears.  

Clicking on  in the application toolbar would start printing immediately 

without displaying the "Print" window.  

3. Make the necessary settings (number of pages and copies).  
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4. Click on Print. 

The device description is printed out on the selected printer as defined by 

default.  

If desired, the print layout can be changed individually (see section 5.1.5 

"Defining the print layout for device descriptions").  

A preview prior to printing can also be performed (see section 5.1.8 

"Previewing the printout on the screen").  

5.1.8 Previewing the printout on the screen 

The "Print Preview" function allows you to check the result of the page setup by 

previewing the printout on the screen prior to printing.  

Procedure: 

1. Activate the device description window you want to preview on the screen.  

2. Click on  in the application toolbar or select Print preview from the File 

menu.  

The "Print Preview" window appears.  

 

The parameter designations are listed in the left column, the parameter values 

in the right column.  

3. Select the display size by clicking one of the icons in the top line of the 

window:  

  
Display original size (100 %) 

  
Display page width 

  
Display whole page 

  
Display two pages 
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Stepwise increase the display size 

  
Stepwise decrease the display size 

 

4. If you are looking for a specific parameter designation or value you can either 

navigate to the corresponding position by scrolling with the mouse wheel or 

by using the scroll bar or you can use the search function (full text search) in 

the bottom line of the window:  

 

Enter the text to find in the entry box. Clicking on the blue arrows finds the 

next or previous occurrence of the text string and highlights it in the page 

preview. In the drop down list behind the blue arrows you can select match 

criteria, e.g. match case.  

5. Click on  if you want to copy a previously highlighted text section into the 

Windows clipboard from where you can insert it into a document using the 

insert function [Ctrl]+[V].  

6. Click on  if you want to print the device description.  

The "Print" window appears (the dialog language depends on the version of 

your Windows user interface).  

Make the necessary settings (printer selection, printer properties, paper size, 

source and orientation) then click on Print.  

7. Close the "Print Preview" window if you don't want to print the device 

description.  
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5.1.9 Switching the status bar on and off 

The "Status bar" toggle function enables you to hide or show the status bar in the 

main window of the application.  

Procedure: 

1. Select Status bar from the View menu.  

A tick in front of the menu item indicates that the status bar is currently 

switched on. After clicking on the menu item the tick in front of it disappears 

and the status bar is no longer visible.  

 

2. Select Status bar again from the View menu, if you want to show the status 

bar (toggle function).  

No tick in front of the menu item indicates that the status bar is currently 

invisible. After clicking on the menu item the tick in front of it reappears and 

the status bar is displayed again.  
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5.1.10 Reading device descriptions from a device 

Device descriptions can be read from supported Landis+Gyr devices via the avail-

able communication channels of these devices. Please note that always a new 

device description is created when reading from a device. It is not possible to 

overwrite the currently open device description. 

Procedure: 

1. Prepare the communication as described in section 6.2 "Communication 

settings". 

2. Click on  in the application toolbar or select Load from device from the 

Communication menu. 

The connection to the selected device is established via the selected commu-

nication channel and the device description is read from the device into a 

new device description window. The device identification and the firmware 

version are displayed in the title bar. During the readout process, which can 

take several minutes depending on the number of items to be read, a rotat-

ing display is shown in the device description window. 

 

After completing the readout the device description is displayed.  

 

3. Perform the intended work with the device description: You can edit the 

parameters of the device description (see section 5.2 "Editing parameters"), 

save it (see section 5.1.3 "Saving device descriptions") or write it into a de-

vice (see section 5.3.1 "Parameterisation wizard").  
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5.1.11 Comparing a device description to a file 

This function allows you to compare the displayed device description with a 

device description saved in a file.  

The compare page setup can be defined as described in section 5.1.6 "Defining 

the print layout for compare results".  

Procedure: 

1. Display the device description which you intend to compare with another 

device description saved in a file (proceed as described in section 5.1.2 

"Opening existing device descriptions") or in section 5.1.10 "Reading device 

descriptions from a device"). 

2. Select Compare to file from the View menu.  

The "Open" window appears (this is an operating system dialog window and 

therefore the dialog language depends on the version of your Windows user 

interface).  

 

3. Select your personal data folder in the displayed tree structure if it is not 

already displayed.  

4. Double-click on the desired entry in the list or select it and then click on 

Open.  

The displayed device description will be compared with the selected device 

description and compare result displayed in the "Compare Preview" window.  

The parameter designations are listed in the left column, the parameter values 

of the displayed device description in the centre column and the parameter 

values of the device description from the file in the right column. Differing 

parameter values are highlighted with the defined colour (see section 7.3 

"Defining colours"). 
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See section 5.1.8 "Previewing the printout on the screen" for a description of 

the handling features in the "Compare Preview" window. 
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5.2 Editing parameters 

A parameter can be edited in the detail view of the device description window after 

selecting the parameter or folder containing the parameter in the tree view of the 

device description window (see section 4.4 "Device description window"). 

Depending on the parameter type, parameters can be modified in different 

manners:  

 Entering parameter values in entry boxes (see section 5.2.1) 

 Selecting parameter values in drop down lists (see section 5.2.2) 

 Selecting option parameters (see section 5.2.3) 

 Activating or deactivating checkboxes (see section 5.2.4) 

 Defining lists by selecting objects (see section 5.2.5) 

 Using special functions (e.g. importing time of use tables) (see section 5.2.6) 

The corresponding procedures and special features are explained in the indicated 

sections with some examples. Specific instructions are contained in the functional 

descriptions of the supported devices. 

5.2.1 Entering parameter values 

Certain parameter values can be entered in entry boxes, in the following example 

the deviation of local time to UTC and the maximum time shift without registra-

tion of a clock adjustment event. 

 

The unit of the value is indicated behind the entry box. 

The allowed entry range is indicated with a tooltip if the mouse pointer is posi-

tioned on the entry box (in the example shown the value must be in a range from 

2 to 255 s). 
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If an  icon is displayed behind the entry box, you can position the mouse 

pointer over this icon to display a tooltip with information (more complex instruc-

tions and examples) about the entry box, e.g. about the deviation between local 

time and UTC: 

 

The entries made will be validated against the allowed values. If a value exceeds 

the allowed range this is indicated with a red blinking frame around the entry box 

with red background and a red frame around the area. 

 

If you position the mouse pointer over the error icon , a tooltip with infor-

mation about the error is displayed:  
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5.2.2 Selecting parameter values 

Certain parameter values can't be entered in entry boxes but must be selected 

from a given number of possibilities, in the following example the synchronisation 

look time can only be set to one of the five values presented in the drop down list. 

 

Not only values but also features can be selected in drop down lists. 

 

 

5.2.3 Selecting option parameters 

Certain parameters can be set by selecting one of the indicated options, in the 

following example the date and time reset.  

 

Changing the selection can have an immediate influence on other parameters or 

parameter attributes. In the above example the fields on the right side disappear 

for instance if "undefined" is selected. 
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5.2.4 Activating or deactivating checkboxes 

Certain parameters can be set by selecting several of the indicated options, in the 

following example the standard event trigger sources.  

 

Clicking on a checkbox toggles between activated (tick set) and deactivated (tick 

removed). 

Clicking on the  icon activates all checkboxes.  

Clicking on the  icon deactivates all checkboxes. 

Activating or deactivating a checkbox can have an immediate influence on the 

parameter display. In the following example the maximum demand register para-

meters are only displayed with activated checkbox. 

 

With deactivated checkbox the parameters are not visible. 
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5.2.5 Defining lists by selecting objects 

Certain parameters (e.g. profiles, display lists, service lists etc.) can be set by copy-

ing a number of objects from a choice list into a captured object list and defining 

the order of the selected list entries. 

 

Clicking on  moves the selected entry of the choice list to the captured 

object list (to the first position if no entry is currently selected in the list or other-

wise underneath the selected entry in the list). 

Clicking on  moves the selected entry of the captured object list back to the 

choice list (to the original predefined position). 

Clicking on  or  moves the selected entry of the captured object list 

one position up or down. 
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5.2.6 Using special functions 

Certain parameters can be set using special functions, in the following example 

the definition of time of use tables.  

 

The special functions (import, save, copy, paste, add, remove etc.) can be selected 

by clicking on the corresponding icons (their function is indicated in a tooltip if the 

mouse pointer is positioned on the icon). 

Specific instructions for the use of these functions are contained in the functional 

descriptions of the supported devices. 
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5.2.7 Invalid parameter settings 

Invalid parameter settings are indicated with an error icon  and a red frame 

around the invalid area in the detail view. Additionally, an error icon  is dis-

played in the tree item with the invalid parameter and in all hierarchical higher 

folders. 

 

The reason for the error (in the above example a missing day table) can be indi-

cated with a tooltip if the mouse pointer is positioned on the error icon.  

Please note, that only an error icon is displayed in the tree but not the cause of 

the error. 

 

 Possibility of consecutive errors 

The error indicated in the tree can also be a consecutive error whose reason is 

another modified parameter.  
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5.2.8 Local warnings 

Parameter settings which affect a function – but are not invalid – are identified 

with a local warning indicated in the detail view but not in the tree. Such para-

meter settings are admissible (i.e. they may be intended) and do not need to be 

corrected.  

The local warning is indicated with a warning icon  (e.g. in lists) or with an 

orange frame (e.g. around entry boxes).  

In the example below the warning icons indicate, that the corresponding registers 

are inactive (because the energy registers 13 to 16 have been disabled). By posi-

tioning the mouse pointer on the warning icon the cause of the warning is dis-

played as tooltip.  

 

In the following example the orange frame around the entry box "Threshold" indi-

cates that the supervision has been switched off by entering the value "0".  

 

By positioning the mouse pointer on the on the warning icon or the entry box with 

the orange frame the cause of the warning is displayed as tooltip.  
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5.3 Sending device description or parameter group to a device 

5.3.1 Parameterisation wizard 

The parameterisation wizard is used to write a complete device description or a 

selected parameter group to a device in a secure manner to guarantee that 

devices are parameterised consistently. Therefore the wizard always checks the 

necessary access rights before writing any parameter. Only changed parameters 

are written to the device.  

The following parameter groups can be selected in the parameterisation wizard:  

 All parameters including TOU but without security system 

 TOU only 

 Security system only (access rights, security definitions, passwords) 

For the parameterisation of devices with all parameters except the security sys-

tem the parameterisation wizard permits the input of individual parameter values, 

such as device and parameterisation identification numbers for convenient para-

meterisation of several devices with the same parameters. The identification 

numbers entered are written to the device instead of the corresponding values 

from the device description. Furthermore the device clock can be set to PC time or 

to PC time plus an offset in the range of ±12 hours. 

The parameterisation wizard also allows actions to be performed after para-

meterisation, e.g. resetting registers and profiles.  

The starting of the parameterisation wizard and its various parameterisation possi-

bilities are described in the following sub-sections. 

Note: The available functions – especially the security system settings – differ 

depending on the device type. 
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5.3.2 Starting the parameterisation wizard 

The precondition for selecting the parameterisation wizard is that a device descrip-

tion is displayed in the .MAP120, either read out from a device, opened as file or 

newly created and edited.  

Procedure: 

Click on  in the application toolbar or select Send to device from the 

Communication menu. 

The window "Step 1: Selection of parameter group" of the parameterisation 

wizard appears, communication is started and the data is read from the con-

nected device.  

The firmware version, the configuration ID and the parameterisation ID of the 

device description (column "Tree") and the device connected (column "Device") 

are displayed in the "Device Information" area, e.g. for a connected E450 

ZMX310G meter: 

 

In the "Parameter Group" area the required parameter group can be selected if 

the indicated conditions are fulfilled: 

 All parameters except security system 

can only be selected if the firmware and the configuration ID of tree and 

device correspond. 

 TOU only 

can only be selected if the tree and the device have a time switch according to 

the configuration and both belong to the same device series. 

 Security System only 

can only be selected if the firmware of tree and device correspond and 

the necessary security level has been selected. Please contact your local 

Landis+Gyr representative to get more information. 
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5.3.3 Parameterising all parameters except security system 

Procedure: 

1. Start the parameterisation wizard (see section 5.3.2 "Starting the parameter-

isation wizard"). 

2. Select the parameter group option "All parameters except security system". 

3. Click on Next >.  

The window "Step 2: Selection of ID numbers and clock handling" appears. 

The device identification numbers and the clock data are displayed. Please 

note that the display is depending on the device connected, i.e. the number 

of available IDs can be different. 

4. Select the IDs which are to be modified and enter the desired values in the 

input boxes of the "Tree" column.  

Please note that the entered values are only used for the parameterisation of 

the device but are not stored in the device description displayed in the 

.MAP120. Only the selected IDs will be written to the device (an empty entry 

box deletes the corresponding value in the device).  

5. Select the desired device clock handling option (the date and time, the DST 

bit and the clock invalid bit of the device clock status are shown): 

– Do not change clock 

– Set clock to PC time 

– Set clock to PC time plus offset (possible range: ± 12 hours) 

 

6. Click on Next >.  

The window "Step 3: Performing parameterisation" appears. In order to 

guarantee that the device is parameterised consistently the wizard checks 

the necessary access rights, reads the data from the device and compares 

the data before writing the changed parameters to the device. The progress 
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of the parameterisation is indicated with a progress bar and a green tick is 

set for every action executed successfully. At the end the currently active 

communication channel will be closed. 

 

7. Click on Next >.  

The window "Step 3: Actions after parameterisation" appears.  
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8. Select the desired resetting actions.  

The possible selection is determined by the configuration of the device and is 

related to the capabilities of the device. 

9. Click on Next >.  

If at least one action was selected, the communication with the device is 

established, the access rights for the selected actions are checked and the 

actions are performed if possible. At the end the currently active commu-

nication channel will be closed and the end window is displayed.  

 

10. Click on Next Device if another device shall be parameterised or click on 

Finish to terminate parameterisation.  

The parameterisation wizard is restarted or terminated depending on the 

button clicked.  
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5.3.4 Parameterising time of use 

1. Start the parameterisation wizard (see section 5.3.2 "Starting the parameter-

isation wizard"). 

2. Select the parameter group option "TOU only". 

3. Click on Next >.  

The window "Step 2: Selection of time of use data" appears.  

4. Select the time of use data to be written to the device (either complete time 

of use or only individual parts). 

 

5. Click on Next >.  

The window "Step 3: Performing parameterisation" appears and the para-

meterisation is performed (see point 6 to 10 in section 5.3.3 "Parameterising 

all parameters except security system").  
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5.3.5 Parameterising device security system 

1. Start the parameterisation wizard (see section 5.3.2 "Starting the parameter-

isation wizard"). 

2. Select the parameter group option "Security System Only". 

3. Click on Next >.  

The window "Step 2: Selection of security system data" appears.  

4. Select the settings which shall apply to all levels:  

– Access Level Definitions (Access and Message Security Settings) 

– Access Rights 

– Changeability of Access Rights 

5. In the "Password (Secret) and Settings per Level" area select one tab after 

the other and where required activate the checkboxes "Access and Message 

Security Settings" and "Access Rights" if not already set for all levels. 

Please note that the number of displayed level tabs is dependent from the 

connected device. 

6. Activate the checkbox "Password (secret)" if the password of the correspond-

ing level shall to be modified and enter the desired values in the "Enter New 

Password (Secret)" window, which appears after clicking on the Edit icon  

in front of the corresponding password entry box.  

Please note that the entered values are only used for the parameterisation of 

the device but are not stored in the device description. Only the selected 

passwords will be written to the device.  

 

Click on  behind the password field, if you want to delete again an entered 

password.  
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7. Click on Next >.  

The window "Step 3: Performing parameterisation" appears and the para-

meterisation is performed (see point 6 to 10 in section 5.3.3 "Parameterising 

all parameters except security system").  
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6 Communication with devices 

This section describes all aspects of communication with devices, in particular the 

communication settings in the Landis+Gyr .MAP120 Parameter Editor for various 

applications.  

6.1 Basic principle 

The communication between the Landis+Gyr .MAP120 Parameter Editor and a 

device via a communication channel is strictly client/server based. The client is 

part of the .MAP120 Parameter Editor, the server is located in the end device 

(e.g. the meter). 

Access Level (Client) 
• application process ID

• security mechanisms

• user ID

• security material

Device (Server)
• device series

• logical device

• physical device address

• security material

Communication Channel
• physical layer (interface)

• link layer protocol

• application layer protocol

• address book

 

The required settings in the Landis+Gyr .MAP120 Parameter Editor comprise the 

following three main areas: 

 Communication channel 

 Device (Server) 

 Access level (Client) 
 

6.1.1 Communication channel 

The communication connection from the Landis+Gyr .MAP120 Parameter Editor 

to one or more devices can be made in various ways:  

 With a serial connection to a device. 

– With an optical reading head placed at the optical interface of the device 

(only point-to-point connection to a device possible).  

– With a Bluetooth reading head (radio transmission over short distances, 

only point-to-point connection to a device possible).  

– With a direct connection to a device, e.g. via an RS232, M-Bus, CS or net-

work interface as used in various communication units. If the communica-

tion unit has a second interface (e.g. RS485), multiple connections are 

possible to further devices.  
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 With a modem connection to a device or several devices, if these are con-

nected together by a multiple connection by RS485, CS or M-Bus. Note: the 

modem must first have been installed and configured on the PC.  

 With a network connection over a network interface or the Internet to one or 

several devices, if these are connected together by a multiple connection by 

RS485, CS or M-Bus.  

In addition to the physical communication channel also various other settings are 

stored here, e.g. used protocol variants, transmission rates, delays, timeouts, etc. 

6.1.2 Device 

In this area, optional device-specific data can be specified. This mainly includes 

the device type or the device series as well as some address information to 

address the device (server) via a multiple connection. 

6.1.3 Access level 

An access level defines all settings required on the Landis+Gyr .MAP side (client). 

This includes in particular the identification of the client as well as the algorithms 

used for the access and message security. If desired, the necessary keys and pass-

words can also be stored. 
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6.2 Communication settings 

All communication settings can be defined and modified in the "Communication 

Settings" window.  

Click on  in the application toolbar or select Communication settings from the 

Communication menu. 

The "Communication Settings" window appears with selected "Connections" tab.  
 

 
 
The "Communication Settings" window is subdivided into the following areas: 

 List of devices (1) with their names and the associated device series. 

– The list can be sorted by any column in ascending or descending order, by 

default the devices are displayed in ascending order by name. 

– The currently selected device is highlighted and the selection is not 

changed by a new sorting. 

 List of communication channels (2) with their names and the associated inter-

face, e.g. COM port, modem or network card.  

– The list can be sorted by any column in ascending or descending order, by 

default the communication channels are displayed in ascending order by 

name.  

– The currently selected communication channel is highlighted and the 

selection is not changed by a new sorting. 

 List of links (3) between devices and communication channels with the possi-

ble additional information, particularly with addresses and phone numbers. 

The items displayed depend on the selected device or communications 

channel (see also section 6.2.5 "Links between devices and communication 

channels").  

 Status bar (4), in which the currently used version of the communication data 

and their location (see section 7.5 "Defining storage location of communica-

tion settings") can be seen as well as the current storage policy of passwords 

and keys (see section 7.6 "Defining storage policy for keys and passwords"). 

 




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In the following figure a device (highlighted blue) is selected in the list of devices. 

All the communication channels not linked are greyed out in the list of communi-

cation channels and the links with their attributes are shown in the list of links. 

 

In the figure below a communication channel (highlighted blue) is selected in the 

list of communication channels. All the devices not linked are greyed out in the list 

of devices and the links with their attributes are shown in the list of links. 

 

6.2.1 Recommended input sequence 

Landis+Gyr recommends defining the required data in the following sequence: 

1. Communication channels (see section 6.2.2 "Communication channel data") 

2. Devices including the corresponding access data (see section 6.2.3 "Device data") 

3. Addresses (see section 6.2.4 "Address data") 

4. Links between devices and communication channels including the relevant 

attributes (see section 6.2.5 "Links between devices and communication 

channels" 
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6.2.2 Communication channel data 

After the installation of the .MAP120 Parameter Editor only a default device 

named "Default Device" and a default communication channel named "Default 

Channel" are defined. These default communication settings are the basis for a 

local readout of a meter with an optical reading head connected to the serial 

interface. At least the serial interface (COM port) has to be adapted in most cases. 

The following basic procedure should be adopted to create and store a new 

communication channel definition (specific examples are given in section 6.5 

"Communication examples"): 

1. Click on  in the application toolbar or select Communication settings 

from the Communication menu. 

The "Communication Settings" window appears with selected tab "Connec-

tions" (as shown here with the default communication settings or with addi-

tional data, if already defined).  

2. Highlight a communication channel in the communication channel list 

(default channel or any other communication channel, if already defined).  

 

3. Click on  in the window toolbar in the "Communication Channels" 

area.  

The "Communication Channel" window appears. The entry box "Name" 

contains the placeholder name "CommunicationChannel", all other fields 

contain a copy of the data of the selected communication channel and can 

now be modified. 
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4. Enter a name for the new communication channel definition in the entry box 

"Name".  

5. Select the interface type of the connected device in the "Interface type" drop 

down list: 

- Serial (optical head or 3-wire) 

- Bluetooth optical head (PMR_1) 

- Bluetooth optical head (PMR_1A) 

- Modem 

- Network 

6. Select the used interface in the "Physical interface" drop down list: 

- an available COM port if "Serial" or "Bluetooth optical head" was selected 

as interface type (the COM port number of a serial interface can be found 

in the Windows device manager), 

- an available modem if "Modem" was selected as interface type or 

- an available network adapter if "Network" was selected as interface type. 

7. Select the suitable template for the communication channel settings in the 

"Template for lower layer settings" drop down list. The following templates 

are available (selection possibilities dependent on the selected physical 

interface and interface type): 

- Serial - IEC 

(start protocol IEC with 300 bps) 

- Serial - dlms 

(DLMS/HDLC protocol with 9600 bps) 

- M-Bus - dlms 

(DLMS/HDLC protocol with 9600 bps and 9 Bit transmission) 
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- Bluetooth - IEC 

(same as "Serial – IEC", but with special control of the Bluetooth reading 

head) 

- Bluetooth - DLMS 

(same as "Serial – dlms", but with special control of the Bluetooth reading 

head) 

- PSTN Modem 

(DLMS/HDLC protocol with extended timeouts of 5 s) 

- GSM Modem 

(DLMS/HDLC protocol with extended timeouts of 10 s) 

- Wired - HDLC 

(DLMS/HDLC protocol via wired network, e.g. Ethernet) 

- Wired - Wrapper 

(DLMS/Wrapper protocol via wired network, e.g. Ethernet) 

- Wireless - HDLC 

(same as "Wired – HDLC", but with extended timeouts since the 

transmission times can be significantly higher e.g. with GPRS) 

- Wireless - Wrapper 

(same as "Wired – Wrapper", but with extended timeouts since the 

transmission times can be significantly higher e.g. with GPRS) 

After selection of a template the button "Apply" is activated. If you click on it, 

all communication channel settings are set automatically according to the 

template.  

8. Now you can directly continue according to subsection 6.2.2.5 "Terminating 

the communication channel definition" or check the settings on each tab 

according to the following subsections.  
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6.2.2.1 Physical Layer 

1. Select the "Physical Layer" tab. 

Depending on the interface type selected the setting possibilities are 

different. 

If interface type "Serial" or "Bluetooth optical head" is selected: 

 

2. Select the transmission rate corresponding to the device in the "Transmission 

speed" drop down list for local communication.  

3. Select the required communication port settings in the "Port settings" drop 

down list:  

- 8 Bit (8 data bits / no parity) (default), to be used normally 

- 9 Bit (8 data bits / even parity), to be used if the connection to the serial 

interface of the PC is made via an USB M-Bus converter 

4. Tick the "Idle time after connection" checkbox if you want to modify the 

default initial delay (IEC standard value = 0 ms). Then enter the required 

value in the "Idle time after connection" entry box.  
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If interface type "Network" is selected: 

 

2. Select the required communication protocol in the "Protocol" drop down list:  

- TCP (Transmission Control Protocol) 

- UDP (User Datagram Protocol) 

3. If required enter a source port number (only if IPv6 is used) otherwise do not 

change the default setting "0" (automatic selection).  

4. Tick the "Idle time after connection" checkbox if you want to modify the 

default initial delay (IEC standard value = 0 ms). Then enter the required 

value in the "Idle time after connection" entry box.  
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If interface type "Modem" is selected: 

 

2. Tick the "Idle time after connection" checkbox if you want to modify the 

default initial delay (IEC standard value = 0 ms), e.g. with GSM networks. 

Then enter the required value in the "Idle time after connection" entry box.  
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6.2.2.2 dlms Link Layer 

1. Select the "dlms Link Layer" tab.  

The settings on this tab apply if the DLMS protocol is used. 

2. Select the required protocol for the planned activity in the "dlms Link layer 

protocol" drop down list. Possible settings:  

- HDLC, if the HDLC protocol must be used 

- HDLC via IEC mode E (default), if the IEC protocol must be used for 

opening the communication 

- COSEM Wrapper, if the COSEM Wrapper over the TCP protocol must be 

used  

 

3. Depending on the selected link layer protocol, the IEC Mode E, HDLC or 

COSEM Wrapper areas are displayed to make the required settings. 

In the IEC Mode E area (only displayed if "HDLC via IEC mode E" is selected as 

link layer protocol):  

- Transmission Speed Switching: Select the required maximum transmission 

rate (default = 9600 bps). Untick the checkbox if you don't want to allow 

transmission rate switching. 

Note: In case of modem or network connections no real change is made 

but only the transmission rate character in the protocol is altered. 

- Intercharacter Timeout: After expiration of the set time the transmission 

is automatically ended if no further data is transmitted. If you untick the 

checkbox, no automatic termination of the transmission occurs. 

- Maximum Number of Retries: Select the number of retries (default value 

= 3). If you select 0, no retries occur. 
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In the HDLC area (only displayed if "HDLC" or "HDLC via IEC mode E" is 

selected as link layer protocol):  

- Maximum HDLC Buffer Size: Tick the checkbox if you want to modify the 

default value (128 bytes). The HDLC buffer size determines how many 

useful data can be transmitted in one data packet. Reduce the value in 

case of communication problems. 

- Message Timeout: If you untick the checkbox, no automatic termination 

of the transmission occurs. 

- Maximum Number of Retries: Select the number of retries (default value 

= 3). If you select 0, no retries occur. 

In the COSEM Wrapper area (only displayed if "COSEM Wrapper" is selected 

as link layer protocol):  

- Message Timeout: If you untick the checkbox, no automatic termination 

of the transmission occurs. 

6.2.2.3 dlms Application Layer 

1. Select the "dlms Application Layer" tab.  

The settings on this tab apply if the DLMS protocol is used. 

 

2. Select "Short Name (SN) referencing" or "Logical Name (LN) referencing" 

method. The command set supported by LN referencing is very limited. The 

.MAP tools only work with short names. Therefore SN referencing is the 

preferred choice unless otherwise instructed. 

3. Tick the "Maximum Number of Elements in Lists" checkbox to activate the 

use of lists for read and write operations. Enter the maximum number of 

elements in lists. In case of readout problems this value (default = 45) can be 

reduced down to 1. It should be noted that this slows down the readout 

significantly.  
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4. If required, modify the "Single Request Firmware Releases". This entry box 

contains all releases (separated by semicolons), for which automatically 

single requests will be used, i.e. no list requests are used.  

5. Tick the "Maximum dlms Buffer Size" checkbox if you want to limit the maxi-

mum buffer size in the .MAP tool for writing of data (default value = 0). Then 

enter the required value in the "Maximum dlms Buffer Size" entry box. 

Principally the buffer sizes for writing and reading reported from the device 

are used. If a maximum buffer size is determined, this size is not exceeded 

during writing, even if the device reports a bigger write buffer size. If you 

untick the checkbox, the buffer size is unlimited, i.e. buffer size indicated by 

the device is used. 

6. Tick the "Block transfer with set, write and action services supported" check-

box if you want to allow write operations with blocks and if your device also 

supports block transfers. The use of blocks for writing depends on the data 

quantity, the maximum number of list items and the DLMS buffer size. It is 

recommended to disable this setting in case of transmission problems. 

7. Keep alive interval: After this time an "Alive-Packet" is to be sent in order to 

maintain the connection. The value must be greater than the message time-

out value (default = 30 s). If you untick the checkbox, the function is switched 

off.  

8. Tick the "Use release service to close Association Application" checkbox if a 

release request shall be sent before closing the HDLC connection (with 

COSEM Wrapper a release request is always sent).  
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6.2.2.4 IEC 

1. Select the "IEC" tab.  

The settings on this tab apply for devices that support solely the IEC protocol. 

 

2. Select the required maximum transmission rate (default = 9600 bps) in the 

"Transmission Speed Switching" drop down list. Untick the checkbox if you 

don't want to allow transmission rate switching.  

Note: In case of modem or network connections no real change is made but 

only the transmission rate character in the protocol is altered. 

3. Intercharacter Timeout: After expiration of the set time the transmission is 

automatically ended if no further data is transmitted. If you untick the "Inter-

character Timeout" checkbox, no automatic termination of the transmission 

occurs. 

4. Select the number of retries (default value = 3) in the "Maximum Number of 

Retries" entry box. If you select 0, no retries occur. 

5. Enter the required static password (8 characters) for R5/W5 commands in the 

"Password for R5/W5 Commands" entry box.  

6. Enter the maximum length in bytes of the R1/W1 commands in the "Maxi-

mum R1/W1 Command Size" entry box.  

This value limits the block size for the transmission of large amounts of data, 

e.g. display lists or tables of use. Values greater than 16 bytes are not sup-

ported by all devices. Please refer to the respective device documentation to 

find out which values are supported by your device.  
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6.2.2.5 Terminating the communication channel definition 

1. Click on OK.  

The new communication channel definition is saved. A new entry with the 

defined name appears in the communication channel list.  

 

2. Define further required communication channels in the same way.  

3. Close the "Communication Settings" window.  

 

 Modifying or deleting communication channel definitions 

If you intend to modify or delete a communication channel definition, mark the 

corresponding entry in the communication channel list and then  

 click on  in the window toolbar in the "Communication Channels" area 

to modify the marked entry of the communication channel list or double click 

on the entry.  

 click on  in the window toolbar in the "Communication Channels" 

area to delete the marked entry of the communication channel list (deletions 

must be confirmed).  
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6.2.3 Device data 

After the installation of the .MAP120 Parameter Editor, only a default device 

named "Default Device" and a default communication channel named "Default 

Channel" are defined. These default communication settings are the basis for a 

local readout of a meter with an optical reading head connected to a serial 

interface. 

Additionally, other device-specific properties can be defined here, if required.  

The following basic procedure should be adopted to create and store a new 

device definition (specific examples are given in section 6.5 "Communication 

examples"): 

1. Click on  in the application toolbar or select Communication settings 

from the Communication menu. 

The "Communication Settings" window appears with selected tab "Links". 

2. Highlight a device in the device list (any device or other device, if already 

defined). 

 

3. Click on  in the window toolbar in the "Devices" area. 

The "Device" window appears. The entry box "Name" contains the place-

holder name "Device", all other boxes contain the data of the selected device 

and can now be modified. 
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4. Enter a name for the new device definition in the entry box "Name".  

6.2.3.1 Type 

1. Select the "Type" tab.  

 

2. Select the device series in the "Device Series" drop down list. 

The selected device series has the effect, that the command tree will be 

changed accordingly, if the device is selected in the device toolbar. If you 

leave "undefined", no adaptation of the command tree occurs.  
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3. If required, enter the manufacturer serial number with a maximal length of 

20 characters and a restricted character set ('0'..'9', 'A'..'Z', 'a'..'z') in the 

"Manufacturer Serial Number" entry box.  

Please note that this entry has currently no meaning but may be used for 

extended device management in the future. 

4. Select the device type in the "Logical Device" drop down list: "Base Meter / 

Module" (=1) or "Communication Unit" (=17) or "user defined" for devices 

from third party suppliers (in this case, you must enter the logical device 

number according to the manufacturer information). 

Note that this selection is only possible if the device series is set to "unde-

fined". Otherwise it is fix set to "Base Meter / Module" (=1) or "Communica-

tion Unit" (=17), depending on the selected device series. Also note that the 

logical device may be overridden by a command in some cases, if the com-

mand is implemented only for a specific logical device (e.g. communication 

unit).  

6.2.3.2 Address 

1. Select the "Address" tab, if a device address shall be used. 

2. Set a tick to the "IEC address" and/or "HDLC address" checkbox and enter 

the address(es).  

If you enter an IEC address first and then click on the arrow button behind 

the two entry boxes, the HDLC address is automatically calculated and 

entered (see section 6.3 "Addressing devices").  
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6.2.3.3 Access levels 

The various access levels and their fields of application are described in section 9 

"Short description of device security system".  

1. Select the "Clients" tab to define the device-specific access levels. 

 

After the installation of the .MAP120 Parameter Editor no passwords for the dif-

ferent access levels are defined. Therefore only the access levels without pass-

word protection, e.g. "[0] Public Access" or with fix set password as "[F] Manufac-

turer Access" can be used. They are shown in the list of device specific access 

levels by default. For all other required access levels the credentials have to be 

entered as described below or imported (see section 6.2.3.4 "Importing keys"). 

2. Click on Settings.  

The "Access Levels" window appears for the specified device.  

The device name is displayed in the top left corner.  

The window contains a list of all access levels with "Client AP" (User ID, UID), 

authentication, additional requisites, message security policy, security setup 

and supported protocols that can be used for any device.  

An  icon is displayed in the first column as long as the access level is not 

correctly defined (e.g. missing or incomplete password). Accordingly marked 

access levels will not be shown in the Client toolbar.  
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3. Specify the access levels to be used by double clicking the corresponding entry 

(or by selecting it and clicking on the edit icon ) and then making the 

necessary entries in the appearing "Access level Definition" window.  

Depending on the access level to be defined and other inputs, the individual 

fields can be modified or are set immutable.  

 

4. Only for user defined access levels: Enter a "Client Application Process ID" 

(default is 16). 

For all other access levels the "Client Application Process ID" is fix assigned in 

a range from 1 to 255 and cannot be changed.  

5. Tick the "User ID" checkbox if you want to send additional information about 

the user to the device and then enter a user ID in the range from 1 to 255 (0 

= don't use a user ID). The device only allows to establish a connection if this 

user ID is also enabled there. 
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A user ID is currently only supported by a few devices. Please refer to the 

respective device documentation to find out whether this is supported by 

your device or not (not to be selected as default).  

6. Only for user defined access levels: Select the type of authentication in the 

"Authentication" drop down list.  

The selection is described in section 9.2 "Security attributes" under "Access 

authentication"). For all other access levels the authentication is fix assigned 

and cannot be changed.  

The unchangeable display "Additional requisites" shows information about 

specific access levels as "service menu required" or "hardware switch re-

quired".  

7. Only for access levels with high level authentication using GMAC and SHA-

256: Tick the "Authenticated" and or "Encrypted" checkboxes for the corre-

sponding message security (for both request and response).  

"Signed" is reserved for future use and can therefore not be selected. 

8. Only for access levels with low level authentication or with high level 

authentication using SHA-1:  

Click on the edit icon  and then enter the password or key in the appea-

ring "Enter new password (secret)" window either as visible string or hexa-

decimal and then confirm the entry with OK. 

 

For security reasons, the password (secret) is only visible as you type it in. After 

entering a placeholder is shown with asterisks. In case of a future modification, 

it must be re-entered.  
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Click on the  icon behind the password entry box if you want to delete a 

previously defined password (secret).  

9. Only for access levels with high level authentication: Either import the 

required authentication and/or encryption keys (GAK and GUEK) from a 

received key file (see section 6.2.3.4 "Importing keys") or  

click on the corresponding edit icon  and type in the key in the "Enter 

new key" window either as visible string or hexadecimal and then confirm 

the entry with OK.  

 

For security reasons, the key is only visible as you type it in. After entering a 

placeholder is shown with asterisks. In case of a future modification, it must be 

re-entered.  

 

The fixed display "Supported protocols" shows the supported protocols for 

the access level. Possible values are "IEC and dlms" and "dlms only".  
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10. Click on OK.  

The "Access Levels" window appears again.  

No  icons are displayed in the first column of the newly defined access 

levels.  

 

11. Click on OK.  

On the "Clients" tab of the "Device" window the defined device-specific 

access levels are displayed.  

 

All these fully defined access levels can be selected in the "Client" drop down 

list in the client toolbar if the corresponding device is selected in the "Device" 

drop down list. 
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12. Continue as described in section 6.2.3.5 "Terminating the device data 

definition". 

6.2.3.4 Importing keys 

If the authentication and/or encryption keys are not available in a legible form, 

you can import them from key files (offline) or from a remote key management 

system (online).  

Offline key import 

 

 Required key files 

The required key files will be supplied to you by your Landis+Gyr representative.  

 

 

Proceed as follows to import keys from key files: 

1. Click on Import all Credentials (Offline).  

The "Import Keys" window appears. 
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2. Click on  in the "Encryption Keys" area. 

The "Open" window appears.  

3. Select the directory where the encryption key file is stored in the displayed 

tree. 

4. Select the encryption key file you want to import. 

 

5. Click on Open.  

The keys are imported from the encryption key file and the available device 

serial numbers will be listed in the "Device Selection" area.  
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6. Click on  in the "Utility Key" area. 

The "Open" window appears.  

7. Select the directory where the utility key file is stored in the displayed tree. 

8. Select the utility key file you want to import. 

This file is required to decrypt the key file. 

 

9. Click on Open.  

The utility key is imported from the key file.  
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10. Click on OK.  

The "Import Keys" window disappears and the associated device-specific 

access levels are displayed.  

 

 

Online key import 

 

 Required prerequisites 

Before you can import keys online from a remote key management system the 

required credentials must have been entered on tab "Key Management system" 

in the "Options" window (see section 7.7 "Defining the key management system").  
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Proceed as follows to import keys from a remote key management system: 

1. Click on Import all Credentials (Online).  

The "Import Keys" window appears. 
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2. In column "Import" set a tick to all access levels for which you want to import 

keys from the remote key management system.  

 in the window toolbar selects all checkboxes and  

 in the window toolbar unselects all checkboxes. 

3. Click on  in the window toolbar or on Request keys from remote 

system.  

If the keys are available on the remote key management system they will 

be imported. This is indicated with "Success" in column "Status" and with 

"Import succeeded" in the "Import information" area.  

If a key is not available on the remote key management system this is indi-

cated with "Missing" in column "Status" and with "No appropriate data in 

response" in the "Import information" area (in this case the OK button is not 

released; untick the checkbox for the corresponding access level and repeat 

the request). 

 

4. Click on OK.  

The "Import Keys" window disappears and the associated device-specific 

access levels are displayed.  
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6.2.3.5 Terminating the device data definition 

1. Click on OK.  

The new device definition is saved. A new entry with the defined name 

appears in the device list.  

 

2. Define further devices in the same way, if required.  

3. If you have imported address data from a MAP110 phone book, modify the 

"undefined" device series to the appropriate device series and delete im-

ported devices which are not required. 

4. Close the "Communications settings" window. 

 

 Link to communication channel is required 

Each device must be linked to at least one communication channel (see section 

6.2.5.1 "Defining link between device and communication channel"), so that it can 

be used.  

 

 Modifying or deleting device definitions 

If you intend to modify or delete a device definition, mark the corresponding 

entry in the device list and then  

 click on  in the window toolbar in the "Devices" area to modify the 

marked device definition or double click on the device definition.  

 click on  in the window toolbar in the "Devices" area to delete the 

marked device definition. Deletions must be confirmed.  

The default device definition "any device" can't be deleted. 
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6.2.4 Address data 

After the installation of the .MAP120 Parameter Editor, no address data 

(IP addresses and phone numbers) are defined.  

Proceed as described in the following subsections to generate address book 

entries.  

6.2.4.1 Phone numbers 

Define the phone numbers required for modem connections as follows:  

1. Click on  in the application toolbar or select Communication settings 

from the Communication menu. 

The "Communication Settings" window appears with selected tab 

"Connections". 

2. Select the "Address Book" tab. 

 

3. Click on  in the window toolbar for phone numbers (right window). 

The "Address Book" window appears. 

4. Enter a clear designation of the device in the "Name" entry box and the 

phone number of the desired device in the "Phone number" entry box. 

 

5. Click on OK.  

The "Address Book" window disappears. The phone number is saved and 

then appears as entry in the address book.  
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6. Define further phone numbers in the same way, if required.  

7. Close the "Communications settings" window. 

 

 Modifying or deleting phone numbers 

If you intend to modify or delete a phone number, select the corresponding entry 

in the phone number list and then then 

 click on  in the window toolbar in the "Phone Numbers" area to 

modify the marked entry of the address book or double click on the entry.  

 click on  in the window toolbar in the "Phone Numbers" area to 

delete the marked entry of the address book (deletions must be confirmed).  
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6.2.4.2 IP addresses 

Define the IP addresses required for TCP/IP connections as follows:  

1. Click on  in the application toolbar or select Communication settings 

from the Communication menu. 

The "Communication Settings" window appears with selected tab 

"Connections". 

2. Select the "Address Book" tab. 

 

3. Click on  in the window toolbar for IP addresses (left window). 

The "Address Book" window appears. 

4. Enter a clear designation of the device location in the "Name" entry box. 

5. Select with the corresponding radio button whether an IPv4 address or an 

IPv6 address or an URL shall be entered. Enter the IPv4 or IPv6 address or 

the URL in the corresponding entry box and the port number of the desired 

device in the "Port" entry box. 
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Please note that when you use an URL, a corresponding service must be active 

(e.g. dyn DNS), which forwards the requests to the correct address in the 

underlying network.  

6. Click on OK.  

The "Address Book" window disappears. The IP address is saved and then 

appears as entry in the address book.  

 

7. Define further IP addresses in the same way.  

8. Close the "Communications settings" window. 

 

 Modifying or deleting IP addresses 

If you intend to modify or delete an IP address, select the corresponding entry in 

the IP address list and then then 

 click on  in the window toolbar in the "IP Addresses" area to modify 

the marked entry of the address book or double click on the entry.  

 click on  in the window toolbar in the "IP Addresses" area to delete 

the marked entry of the address book (deletions must be confirmed).  
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6.2.4.3 Importing address book 

If the Landis+Gyr MAP110 Service Tool is already installed on the PC, its phone 

book can be imported. Likewise, the address book of a Landis+Gyr .MAP tool from 

another source (e.g. from another PC or another directory) can be imported.  

Import an existing address book as follows:  

1. Click on  in the application toolbar or select Communication settings 

from the Communication menu. 

The "Communication Settings" window appears with selected tab "Links". 

2. Select the "Address Book" tab. 

 

3. Click on  in the window toolbar for IP addresses or phone numbers. 

The "Open" window appears.  

4. Select in the "Open" window the phone book file to be imported (the corre-

sponding directory of the latest installed MAP110 release 3.x will be selected 

by default, to directories of other .MAP releases you must navigate yourself):  

- "PhoneBook.xml" for importing a MAP110 phone book or  

- "AddressBookVxx.xml" (xx = data version) for importing a .MAP phone 

book. 

5. Click on Open. 

All IP addresses and phone numbers are imported from the selected address 

book if not already existing in the .MAP110 address book. The imported data 

appear as entries in the IP addresses list and in the phone number list.  

When a MAP110 phone book "PhoneBook.xml" has been imported, addition-

ally all device addresses are converted into devices.  
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6. Close the "Communications settings" window. 

7. If you have imported address data from a MAP110 phone book "PhoneBook.xml", 

check the device settings (see section 6.2.3 "Device data") again, since device 

addresses from the imported phone book have been converted into devices. 

Before you can use the device definitions created that way these have to be 

linked manually with a communication channel (see section 6.2.5 "Links 

between devices and communication channels").  

 

 Modifying or deleting address book entries 

If you intend to modify or delete an address book entry, select the corresponding 

address book entry in the IP address or phone number list and then then 

 click on  in the window toolbar in the "IP Addresses" or "Phone 

Numbers" area to modify the marked entry of the address book or double 

click on the entry.  

 click on  in the window toolbar in the "IP Addresses" or "Phone 

Numbers" area to delete the marked entry of the address book (deletions 

must be confirmed).  
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6.2.5 Links between devices and communication channels 

Device and communication channel are connected by a link in an appropriate 

manner to each other (see the overview below) to allow a flexible and convenient 

use.  

Address Book
• IP addresses (IPv4, IPv6, 

URL)

• phone numbers

Device (Server)
• device series

• logical device

• physical device address

• encryption keys

Communication Channel
• physical layer (interface)

• link layer protocol

• application layer protocol

Link
• use of physical address

• remote address

• gateway

 

 

The link determines how a device can be reached via a communication channel. 

Each device must be linked to at least one communication channel, so that it can 

be used. 

Only the available (linked) communication channels can be selected in the 

"channel" drop down list (see section 4.3.5 "Communication channel toolbar") 

for a specific device. 

For each device/communication channel link the following attributes can, if 

required, be defined:  

 IEC address (if defined for the device) 

 HDLC address (if defined for the device) 

 Phone number (for modem communications channels only) 

 IP address and port number (for TCP/IP communication channels only) 

 dlms gateway network ID and network address 

If a DLMS device in a local network is not directly accessible, a dlms gateway 

must be used (e.g. Zigbee device via Ethernet gateway). The dlms gateway 

requires additional information in order to forward DLMS requests to the 

correct device in the local network. 

Each defined device can be linked to one or more defined communication 

channels and each communication channel with one or more devices. 
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6.2.5.1 Defining link between device and communication channel 

Procedure: 

1. Click on  in the application toolbar or select Communication settings 

from the Communication menu. 

The "Communication Settings" window appears with selected tab 

"Connections". The device list and the communication list are displayed. 

 

2. Select a device from the device list (or alternatively a channel from the com-

munication channels list). 

3. Click on  in the window toolbar in the "Devices" area (or alterna-

tively in the "Communications Channels" area). 

The "Device/Communication Channel Link" window appears with the device 

fixed and the communication channel selectable: 
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or alternatively with the communication channel fixed and the device 

selectable: 

 

4. In the "Communication Channel" drop down list select one of the defined 

communication channels (or alternatively in the "Device" drop down list one 

of the defined devices). 

5. If more than one communication channel is defined for a device, one channel 

can be determined as preferred channel. When selecting this device the pre-

ferred channel is always selected as default channel. Tick for this the check-

box "This is the preferred channel for this device". The preferred channel is 

then marked with a yellow star in the "Communication Settings" window. 

6. Only for modem communication channels: in the "Phone Number" drop 

down list select one of the defined phone numbers. 

7. Only for TCP/IP communication channels: in the "Destination Server" drop 

down list select one of the defined IP addresses. 

8. If the IEC or HDLC address defined for the device shall be used: set a tick to 

the "Use IEC address" or "Use HDLC address" checkbox. See also section 6.3 

"Addressing devices"). 

9. If a dlms gateway shall be used: set a tick to the "dlms Gateway" checkbox, 

select a network ID and define the additional information in order to forward 

DLMS requests to the correct device in the local network: 

– the network must be identified by a number (network ID) and 

– the address of the device in the local network must be specified in the 

correct format (network address).  

 

 dlms Gateway feature not yet supported by Landis+Gyr devices 

Please note that the dlms gateway feature is for future expansion only and not yet 

supported by the Landis+Gyr devices. For the time being make sure to disable it.  
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6.2.5.2 Terminating the link definition 

1. Click on OK.  

The "Device/Communication Channel Link" window disappears and the new 

defined link is displayed in the communication channel links list.  

2. If more than one communication channels shall be usable to access the 

device (or alternatively if more than one device shall be accessible via the 

communication channel), define another link the same way.  

 

3. Define the links for all devices (or alternatively for all communication 

channels) the same way.  

4. Close the "Communications settings" window. 

 

 Modifying or deleting links 

If you intend to modify or delete a link, select the corresponding entry in the link 

list and then  

 click on  in the window toolbar in the "Links" area to modify the 

marked entry of the link list or double click on the entry.  

 click on  in the window toolbar in the "Links" area to delete the 

marked entry of the link list (deletions must be confirmed).  

Note: Links related to the default device "Default Device" can't be deleted, they 

only can be edited.  
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6.3 Addressing devices 

For point-to-point connections, the device does not need to be specially addressed. 

However, with multi-drop, all devices connected to a bus system (RS485 or CS) 

must have their own address for individual access. This address is called the 

physical device address. In fact, even two physical device addresses are used, one 

for the IEC protocol (IEC device address) and the other for the DLMS protocol 

(HDLC device address).  

Unless otherwise specified on the order, the following parameter values are set as 

defaults for these physical device addresses: 

 Physical IEC device address = serial number (printed on face plate of device), 

e.g. 73852799. 

 Physical HDLC device address = last 4 digits of serial number plus 1000 

(because with DLMS the range of addresses is limited and some addresses are 

reserved), e.g. 3799 for a serial number 73852799 (2799 + 1000 = 3799). 

The physical device addresses are saved as parameters of the basic meter and not 

in the possibly used E65C communication unit. A change of the E65C communica-

tion unit does therefore not affect the addressing. With the Landis+Gyr .MAP110 

Service Tool, the physical device addresses of the devices can be read with the 

read commands under "Communication" or modified with the write commands 

under "Communication".  

6.4 Establishing the communication with devices 

Once the communication settings have been made (see section 6.1 "Basic 

principle") the communication with a device can be established as follows: 

 Select (optional) the required device from the "Device" drop down list or use 

the setting "any device".  

 Select the required communication channel from the "Channel" drop down 

list. 

Only those communication channels linked to the selected device are avail-

able. In the case of "any device" all communication channels are available.  

 Select the required access level from the "Client" drop down list (for modem 

connections the predefined access level is used and the drop down list is 

inhibited until the connection is established, then the selection is possible).  

Only access levels, which have been defined completely in the communication 

settings, are displayed for selection (see also section 6.2.3.3 "Access levels"). 

The device-specific access levels appear with attached device name at the top 

of the list.  

 Only for modem connections: select the required phone number from the 

"Phone" drop down list. 

 Only for modem connections: click on  in the address toolbar to establish 

the connection to the device. 

 Only for network connections: select the required IP address number from the 

"IP Address" drop down list. 

 Perform the intended activity. 
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6.5 Communication examples 

This section provides some examples to show how communication connections 

are made to devices via various communication paths and for various applicati-

ons:  

 Serial connection via the optical interface (see section 6.5.1) 

 Modem connection (see section 6.5.2) 

 Network connection via a LAN (see section 6.5.3) 

 Network connection via a WLAN and the Internet (see section 6.5.4) 

It is assumed in all examples that the physical connections (e.g. cable or modem 

connections) have already been made and the Landis+Gyr .MAP120 Parameter 

Editor has already been started.  

6.5.1 Serial connection via the optical interface 

This example shows how a local connection is made to a device via the optical 

interface. Depending on the device series used DLMS or IEC is used as 

communication protocol.  

 
E450 meter 

ZMX300Px

Serial connection 
(USB or COM port)

PC with .MAP120

Optical
reading 
head

 

Procedure: 

1. In the "Device" drop down list, select the desired device (e.g. E450 meter) 

and in the "Channel" drop down list the corresponding channel (if more than 

one channel is assigned to this device) or create a new device definition with 

the following settings (procedure see section 6.2.2 "Communication channel 

data" and section 6.2.3 "Device data"): 

- Physical interface = COM-Port assigned to the serial interface 

- Interface Type = Serial (optical head or 3-wire) 

- Template for lower layer settings = Serial – dlms or "Serial – IEC" 

according to the device used.  

2. In the "Client" drop down list select the required access level for the 

intended activity e.g. "[2] Utility Field Service".  

3. Perform the intended activity. 
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6.5.2 Modem connection 

This example shows how a point-to-point connection is made for remote commu-

nication with an E450 ZMX300Gx meter (with 2G/3G communication module).  

 
E450 meter 

ZMX300Gx

USB

PC with .MAP120

GSM

Modem

 

Procedure: 

1. In the "Device" drop down list, select the desired device (e.g. E450 meter) 

and in the "Channel" drop down list the corresponding channel (if more than 

one channel is assigned to this device) or create a new device definition with 

the following settings (procedure see section 6.2.2 "Communication channel 

data" and section 6.2.3 "Device data"): 

- Physical interface = The available PSTN or GSM modem 

- Template for lower layer settings = PSTN or GSM modem 

2. In the "Client" drop down list select the required access level for the 

intended work e.g. "[G] Management Access".  

3. In the "Phone" drop down list select the required phone number of the 

connected device. If not already predefined, define it (for procedure see 

section 6.2.4 "Address data"). 

4. Click on  in the address toolbar to make connection to the modem. 

While making the connection the Command" window is displayed with a 

progress indication. 

When the connection is made, it is indicated in the status bar.  

5. Perform the intended activity. 

6. Click on  in the address toolbar to conclude the modem connection when 

the work is done.  
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6.5.3 Network connection via a LAN 

This example shows how a point-to-point connection is made via a LAN to a single 

E350 meter equipped with a communication module AD-xE. 

 
E350 meter with 

Ethernet modulePC with .MAP120

Ethernet Ethernet

Switch or Router

 

Procedure: 

1. In the "Device" drop down list, select the desired device (e.g. AD-xE Ethernet 

module) and in the "Channel" drop down list the corresponding channel (if 

more than one channel is assigned to this device) or create a new device 

definition with the following settings (procedure see section 6.2.2 "Commu-

nication channel data" and section 6.2.3 "Device data"): 

- Physical interface = The available network card 

- Template for lower layer settings = Wired – HDLC or "Wired – Wrapper" 

according to the device used.  

2. In the "Client" drop down list select the required access level for the 

intended work e.g. "[2] Utility Field Service".  

3. In the "IP Address" drop down list select the required IP address of the 

connected device. If not already predefined, define it (for procedure see 

section 6.2.4.2 "IP addresses"). 

4. Perform the intended activity. 
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6.5.4 Network connection via a WLAN and the Internet 

This example shows how a point-to-point connection is made via a WLAN and the 

Internet to a single E350 meter equipped with a communication module AD-xG.  
 

E350 meter with 

GPRS modulePC with .MAP120

Internet

 

Procedure: 

1. In the "Device" drop down list, select the desired device (e.g. AD-xG GPRS 

module) and in the "Channel" drop down list the corresponding channel (if 

more than one channel is assigned to this device) or create a new device 

definition with the following settings (procedure see section 6.2.2 "Commu-

nication channel data" and section 6.2.3 "Device data"): 

- Physical interface = The available WLAN network card 

- Template for lower layer settings = "Wireless – HDLC" or "Wireless – 

Wrapper" according to the device used. 

2. In the "Client" drop down list select the required access level for the 

intended activity e.g. "[7] Remote Service".  

3. In the "IP Address" drop down list select the required IP address of the 

connected device. If not already predefined, define it (for procedure see 

section 6.2.4.2 "IP addresses"). 

4. Perform the intended activity.  

6.6 Reference to other documents 

Detailed information about Landis+Gyr Dialog communication solutions can be 

found in the following documents. 

 Data sheets for various devices 

 User manuals for various devices 

 Functional descriptions of devices 

 Detailed application notes for numerous reference applications with various 

devices for different transmission media  

All these documents as well as advisory services are available from the competent 

representative of Landis+Gyr. 
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7 Auxiliary functions 

This section describes auxiliary functions of the Landis+Gyr .MAP120 Parameter 

Editor:  

 Converting ASCII to text or vice versa 

 Changing the language of the user interface 

 Defining colours 

 Switching the saving prompt on and off 

 Defining storage location of communication settings 

 Defining storage policy for keys and passwords 

 Displaying tool help 

 Displaying release notes 

 Displaying the current program release and checking for updates 
 

7.1 Converting ASCII to text or vice versa 

This function allows conversion of ASCII code into text or vice versa. 

Procedure: 

1. Select ASCII character converter from the Tools menu.  

The "ASCII Character Sequence to Text Converter" window appears. 

2. Enter a hexadecimal ASCII character sequence or a text string in the 

corresponding entry box. 

The converted text or sequence is displayed immediately. 

 

3. Click on Copy Hex Stream to copy the content of the hexadecimal ASCII 

character sequence box into the Windows clipboard or click on Copy Text to 

copy the content of the text box into the Windows clipboard.  

You then can insert this to any place using the paste function [Ctrl]+[V]. 

4. Click on Exit to close the "ASCII Character Sequence to Text Converter" 

window. 
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7.2 Changing the language of the user interface 

This function allows changing the language of the .MAP120 Parameter Editor user 

interface.  

Procedure: 

1. Select Startup language from the Tools menu.  

The "Startup Language" window appears.  

 

2. Select the desired language in the drop down list.  

English and German are available.  

3. Click on OK. 

The "Startup Language" window disappears.  

The selected language will be used upon the next startup of the .MAP120 

Parameter Editor.  

7.3 Defining colours 

The colour for modified values in comparisons can be set with this setting.  

Procedure: 

1. Select Options from the Tools menu.  

The "Options" window appears with selected "General" tab.  

 

2. In the "Colours" area click on the button . 

The "Colour" window appears with a colour palette. 

3. Select the desired colour and click on OK. 

The "Colour" window disappears and the selected colour is shown in the field 

"Colour of differences in file comparison". 
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4. Click on OK. 

The "Options" window disappears and the selected colour will be saved.  

7.4 Switching the saving prompt on and off 

With this setting, you can specify whether a saving prompt shall appear when 

closing a modified device description or not.  

Procedure: 

1. Select Options from the Tools menu.  

The "Options" window appears with selected "General" tab.  

 

2. Tick the checkbox in the "Prompt" area if a saving prompt shall be displayed 

before closing a changed device description or remove the tick if you do not 

want to get a prompt.  

3. Click on OK. 

The "Options" window disappears and the saving prompt setting will be 

saved.  
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7.5 Defining storage location of communication settings 

The path to the directory where communication settings are stored can be 

defined with this setting. 

The communication settings can be shared for all .MAP tools. 

Since the keys, passwords and the storage policy are stored encrypted per 

Windows user, the communication settings cannot be used by other Windows 

users on the same PC.  

Procedure: 

1. Select Options from the Tools menu.  

The "Options" window appears with selected "General" tab.  

2. Select the "Communication Settings" tab. 

3. In the "File Locations" area click on  and select a directory in the tree 

appearing or enter the path to the desired directory. 

 

4. Click on OK. 

The "Options" window disappears and the new settings are saved.  

All communication settings are stored in the files "DeviceConnectionSettings 

Vxx.xml", "AddressBookVxx.xml" and "SecuritySettingsVxx.xml" (xx = data version, 

e.g. 12). Please note that these files will not be automatically transferred into the 

new directory. If required, the files have to be copied or moved manually. 

The default directory for an initial installation is "C:\Users\Current 

User\AppData\Local\Landis+ Gyr\dMAP". 
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7.6 Defining storage policy for keys and passwords 

With this setting, you can set the storage policy for passwords and keys. 

 

 Data deletion with each modification 

Any modification in the storage policy causes a deletion of all passwords and keys. 

 

Procedure: 

1. Select Options from the Tools menu.  

The "Options" window appears.  

2. Select the "Communication Settings" tab. 

 

3. Select the desired storage policy. 

permanent: The passwords and keys are permanently stored on the PC. 

never: The passwords and keys are not stored, i.e. they will be lost when you 

exit the .MAP tool.  

limited until: The passwords and keys are stored on the PC until the specified 

expiration date is reached on the PC, and then deleted. 

4. Click on OK. 

The "Options" window disappears and the new settings are saved.  
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7.7 Defining the key management system 

With this setting, you can set the credentials for accessing the productive and test 

key management system. 

 

 Required credentials 

All required credentials will be supplied to you by your Landis+Gyr representative. 

 

Procedure: 

1. Select Options from the Tools menu.  

The "Options" window appears.  

2. Select the "Key Management System" tab. 

 

3. In the selection box "Referenced Key Management System" select 

"Productive System".  

4. Click on  behind the "Url" entry box. 

The "Url" window appears.  

5. Enter the server name in the "Server" entry box and the port number in the 

"Port" entry box. 

The resulting Url is displayed in the corresponding box underneath. 
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6. Click on OK. 

The "Url" window disappears and the Url is displayed in the corresponding 

entry box in the "Options" window.  

7. Enter the user name in the "User" entry box. 

8. Click on  behind the "Password" entry box. 

The "Enter new password (secret)" window appears.  

9. Enter the password as visible string in the "Password (secret)" entry box. 

 

10. Click on OK. 

The "Enter new password (secret)" window disappears and the password is 

displayed with asterisks in the corresponding entry box in the "Options" win-

dow.  

11. Click on  behind the "Certificate" entry box. 

The "Certificate" window appears.  

12. Enter the certificate name in the "Certificate" entry box. 

Klick on Look-up to decrypt the certificate and display the details of the 

certificate. 

 

13. Click on OK. 

The "Certificate" window disappears and the certificate name is displayed in 

the corresponding entry box in the "Options" window.  

14. Enter an unambiguous key label in the "Key Label" entry box. 

Default value is "WK_LG". 

15. Click on  behind the "KEK Share 1" entry box. 

The "Enter Key Encryption Key" window appears.  

16. Enter the key encryption key share 1 (part 1) as hexadecimal string in the 

"KEK Share 1" entry box. 
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17. Click on OK. 

The "Enter Key Encryption Key" window disappears and the key encryption 

key is displayed with asterisks in the corresponding entry box in the "Options" 

window.  

18. Enter the key encryption key share 2 (part 2) in the same way.  

The key encryption key hash value is calculated out of the two parts entered 

and displayed in the "KEK (Hash)" box. 

 

19. In the selection box "Referenced Key Management System" select "Test 

System" and repeat points 4 to 18. 

20. Select the "Renaming" tab if the key management system used has to be 

identified with a client name instead of a COSEM client ID.  

The relation between the COSEM client ID and the client name is defined in 

the file "KMSClientIDMapping.xml". This file has to be adapted according to 

the key management system used.  

21. Tick the checkbox on the "Renaming" tab and click on  to select the 

folder with the file "KMSClientIDMapping.xml" in the "Open" window which 

then appears or enter the path to the file in the entry box.  
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22. Select the "Logging" tab if the queries to the key management system shall 

be logged.  

23. Tick the checkbox on the "Logging" tab and enter the path and the desired 

name of the log file in the entry box. 

The log file will then be created automatically in the corresponding folder. 

As default value the file name "KMSLog.txt" and the default folder of the 

used .MAP120 version is used. 

If you have already created a log file, click on  to select the folder and the 

file in the "Open" window which then appears.  

 

24. Click on OK. 

The "Options" window disappears and the new settings are saved.  
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7.8 Displaying tool help 

This function permits access to the help texts for the Landis+Gyr .MAP120 Para-

meter Editor. These help texts correspond to the contents of this user manual.  

Procedure: 

1. Press function key [F1] or select Help from the Help menu.  

The online help for the Landis+Gyr .MAP120 Parameter Editor appears.  

 

2. Find the desired information.  

Since the help function is a standard Windows function, it will not be 

explained at this point. More details are found in the Windows manual 

belonging to your PC.  

3. Click on  to close the online help. 
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7.9 Displaying release notes 

This function displays the latest read-me file. 

Procedure: 

1. Select Release notes from the Help menu.  

The latest read-me file appears. 

 

2. Obtain the information you are interested in. 

3. Click on Close to close the read-me file again. 
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7.10 Displaying the current program release and checking for updates 

This function permits the display of information on the current program release 

and checking whether the installed .MAP120 release is up to date.  

 

 Internet access required 

To perform a check for updates the PC must have access to the Internet, since the 

.MAP Home Page must be contacted for this. 

 

Procedure: 

1. Select About .MAP120 from the Help menu.  

The "About" window appears. It contains information about the current 

version, the license and the operating system and .NET Framework installed 

on this computer.  

 

2. Click on Check for Update if you want to check whether the installed 

.MAP120 release is up to date.  

An automatic query is performed on the .MAP Home Page to determine the 

latest released release available.  
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The  icon is displayed while the query is performed. 

 

The  icon is displayed, if the installed release is up to date.  

If a later release is available, the  icon appears. To download and install 

the latest release of the .MAP120 software click on this icon or on the MAP 

icon to access the MAP Software Download area.  

If the  icon is displayed, no information is available or the internet access 

failed. 

3. Click on OK. 

The "About" window disappears.  
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8 Support 

The following is designed to help you take the right measure to tackle any pro-

blems you may experience when using the Landis+Gyr .MAP120 Parameter Editor.  

If a problem arises try to solve it yourself first by applying the following measures: 

 Consult the appropriate section of this user manual.  

 Invoke the help function as described in section 7.8 "Displaying tool help". 

 Read the content of the read-me file, supplied with the software as described 

in section 7.9 "Displaying release notes".  

If these measures do not help, contact your local Landis+Gyr representative.  
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9 Short description of device security system 

9.1 Introduction 

The data and parameters of the Landis+Gyr devices are protected against un-

intended or improper access by a flexible, multi-stage security system. It is very 

similar to the one used in computer systems and consists of several access levels 

(users) with different access rights.  

Detailed information on the security system for the relevant devices is provided in 

the corresponding functional descriptions. 

9.2 Security attributes 

For each access level, various security attributes can be defined that must be 

fulfilled to gain access. 

 

Protected by the verification seal, there is for many devices (e.g. under the main 

face plate) a block of security switches or jumpers. Their position must be defined 

in order to gain access to a particular level.  

 

It may be defined that access to a certain level will only be granted from the 

service menu. To enter the service menu, the utility seal must be removed.  

 

For each access level it is defined how the authentication has to be performed. 

The following authentication types are defined: 

 no authentication (access possible without password) 

 low level authentication using a static password 

 high level authentication using a coded password 

 high level authentication using TEA (Tiny Encryption Algorithm) 

 high level authentication using MD5 (Message-Digest Algorithm 5) 

 high level authentication using SHA-1 (Secure Hash Algorithm) 

 high level authentication using SHA-256 (Secure Hash Algorithm) 

 high level authentication using GMAC (Galois Message Authentication Code) 

In some cases multiple authentication types are selectable per access level.  

If a static password is used, the user only needs to know the password. It is 

checked by the device and access is granted if the passwords match.  

For all other passwords and keys the user not only needs to know the password 

but also an encryption algorithm. Due to the encryption, a Landis+Gyr tool is 

required to access such a level. 

 

A password or a key must be defined for some authentication types. Static and 

coded passwords as well as SHA keys comprise 16 characters, TEA and MD5 keys 

32 characters.  

 

The access to a certain level may be restricted so that it is only granted via 

selected communication channels. Access is for instance possible via the optical 

interface, the integrated interface and both communication channels of the 

communication unit.  

 

Switches protected by 

the verification seal 

Entering the service 

menu 

Access authentication 

Passwords/Keys 

Communication channels 
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To ensure the message safety, the messages can be authenticated and/or en-

crypted, provided a high level authentication using MD5, SHA or GMAC is used for 

access authentication. The necessary keys are stored in one or several security 

setup objects. 

9.3 Access levels 

The Landis+Gyr devices feature up to 15 different access levels with different 

access rights to groups of registers and parameters. The access rights per group 

(read and write access) can be individually configured for every access level. 

Each access level is protected by security attributes which must be fulfilled to gain 

access. In order to simplify the handling and to ensure compatibility to other 

device series, most of the security attributes have been partially or completely 

fixed. 

All access levels are technically strictly independent i.e. a higher access level does 

not automatically bear all rights of the lower access levels.  

9.4 Access levels and their application 

The table below describes all access levels with their security attributes and their 

typical application. The access rights are defined by the utility when ordering the 

device. They depend on the needs of the utility and on the national regulations.  

For levels 0 to 4 access is possible via the DLMS and the IEC protocol, for levels 5 

to G via the DLMS protocol only. The UID (user identification) is used in DLMS 

communication to select the access level. 

Please note that not all access levels are available in all devices, the table below 

therefore just gives an overview. Please always refer to the functional description 

of the currently used device.  

 

Level Security attributes Access rights and typical application examples 

0 

Public Access 

UID = 16 

without password 

without breaking a seal 

all interfaces 

This access level is always available. All DLMS devices can 

be accessed on this level. 

Some data can be read but there is no write access.  

1 

Data Collection 

UID = 32 

with static password or high 

level authentication 

without breaking a seal 

interfaces selectable 

Readout of billing data by means of a handheld terminal or 

possibly by a central system. 

All billing data is readable. 

Limited write access possible, e.g. time/date.  

2 

Utility Field Service 

UID = 48 

with coded password, 

encryption key or high level 

authentication 

without breaking a seal 

interfaces selectable 

Landis+Gyr Tool required if 

coded password or 

encryption algorithm is 

used. 

Maintenance tasks. 

All parameters and all billing data are readable. 

Limited write access to uncritical data is possible, e.g. 

device addresses, identification numbers, phone numbers 

etc. 

3 

Utility Service 

UID = 64 

without password 

breaking the utility seal 

necessary 

local interfaces only 

Installation or maintenance work in the utility and in the 

field. 

All parameters and all billing data are readable. 

Limited write access to settable data is possible, e.g. battery 

operating time, switching tables etc. 

Message security 
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Level Security attributes Access rights and typical application examples 

4 

Extended Utility Service 

UID = 80 

without password 

breaking the verification 

seal necessary 

local interfaces only 

Installation or maintenance work in the utility. Verification 

is usually required afterwards. 

All parameters and all billing data are readable. 

Write access to all data is possible, e.g. parameterisation, 

register clearing, password setting etc. 

5  

Extended Consumer 

UID = 17 

with static password 

without breaking a seal 

interfaces selectable 

Write access for the end user. 

All parameters and most billing data are readable. 

Limited write access to the end user data is possible, e.g. 

monitor thresholds. 

6 

Remote Data Collection 

UID = 18 

with static password 

without breaking a seal 

remote interfaces only 

Remote readout of billing data by a central system. 

All billing data is readable. 

Limited write access is possible, e.g. time/date. 

7 

Remote Service 

UID = 19 

with static password 

without breaking a seal 

remote interfaces only 

Installation or maintenance work in connection with a 

central system. 

All parameters and all billing data are readable. 

Limited write access to settable data is possible, e.g. 

switching tables, device addresses, identification numbers, 

phone numbers etc. 

G 

Management 

UID = 1 

with static password or high 

level authentication 

without breaking a seal 

all interfaces 

Installation or maintenance work after verification (locally 

or via a central system). 

All parameters and all billing data are readable. 

Limited write access to settable data is possible, e.g. 

switching tables, device addresses, identification numbers, 

phone numbers etc. 

L 

Access Administrator 

UID = 2 

with static password or high 

level authentication 

without breaking a seal 

all interfaces 

The same purpose as Level G, additionally the access rights 

of the other levels can be modified. 

8  Reserved for future expansion. 

9 

Broadcast 

UID = 102 

without breaking a seal 

remote interfaces only 

Pre-established, to send unconfirmed messages to multiple 

devices (broadcast) not available in .MAP tools. 

A 

Utility Defined 

UID = 22 

attributes selectable at 

ordering time 

No typical application defined.  

Access rights defined at ordering time according to the 

needs of the utility. 

B  Reserved for future expansion. 

C 

Read Administrator 

UID = 96 

with static password 

without breaking a seal 

Allocation of read access rights 

All parameter and all billing data are readable. 

Read access rights for all lower levels (0 to B) can be 

allocated. 

D 

Utility Administrator 

UID = 97 

with coded password 

breaking the verification 

seal necessary 

local interfaces only 

Landis+Gyr Tool required 

because of coded password 

Same as level 4. 

In addition, changes in the utility security system are 

possible: 

Read and write access rights can be adapted and all 

passwords can be changed. 
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Level Security attributes Access rights and typical application examples 

E 

Distributor Service 

UID = 100 

with coded password 

breaking the verification 

seal necessary 

local interfaces only 

Landis+Gyr Tool required 

because of coded password 

Service access of the distributor.  

Identical to level D. 

In addition, changing the access rights and the password of 

the utility administrator is possible. 
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10 OBIS identification codes 

10.1 General description 

For OBIS (Object Identification System) the structure A-B:C.D.E.F applies, whereby 

the individual groups have the following significance: 
 
A  Defines the characteristic of the data item to be identified, e.g. abstract 

data, electricity-, gas-, heat- or water-related data. 

B  Defines the channel number, i.e. the number of the input of a metering 

equipment having several inputs for the measurement of energy of the 

same or different types (e.g. in data concentrators, registration units). This 

enables data from different sources to be identified. 

C  Defines the abstract or physical data items related to the information 

source concerned, e.g. active power, reactive power, apparent power, 

power factor, current or voltage. 

D  Defines types, or the result of the processing of physical quantities accord-

ing to various specific algorithms. The algorithms can deliver energy and 

demand quantities as well as other physical quantities. 

E  Defines the further processing of measurement results to tariff registers, 

according to the tariffs in use. For abstract data or for measurement results 

for which tariffs are not relevant, this value group can be used for further 

classification. 

F  Defines the storage of data according to different billing periods. Where 

this is not relevant, this value group can be used for further classification. 
 
To simplify the reading in the index field, individual groups of the OBIS code can 

be omitted. The abstract or physical data C and type of data D must be shown. A 

full specification of the OBIS identification number system can be found in 

standard IEC 62056-61. 

Only the values of interest to metering devices are explained below with a collec-

tion of examples. 

 

Group A of the OBIS identification can theoretically have values in the range 

between 0 and 9. Only the values 

0 (abstract objects) and   

1 (electricity related objects)   

appear in the Landis+Gyr .MAP120 Parameter Editor. 

 

Group B of the OBIS identification can theoretically have values in the range 

between 0 and 64. Only the values  

0 (no channel specified)   

1 (channel 1) and   

2 (channel 2)   

appear in the Landis+Gyr .MAP120 Parameter Editor. 

 

Group C of the OBIS identification can have values in the range between 0 and 

255. The individual values are differently assigned depending on the value of 

group A. The values for abstract items (group A = 0) are of no interest at this 

point, since they are largely specific to either context, country or manufacturer.  

Group A 

Group B 

Group C 
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The following table shows the values of group C of the OBIS identification for elec-

tricity related objects. It has the form of a matrix and is read as follows: the value 

46 for instance stands for reactive power in the second quadrant for phase L2. 

 

General purpose objects  0   

Active power +A (QI+QIV) 1) ∑ Li 1 L1 21 L2 41 L3 61 

Active power -A (QII+QIII) ∑ Li 2 L1 22 L2 42 L3 62 

Reactive power +R (QI+QII) ∑ Li 3 L1 23 L2 43 L3 63 

Reactive power -R (QIII+QIV) ∑ Li 4 L1 24 L2 44 L3 64 

Reactive power +Ri (QI) ∑ Li 5 L1 25 L2 45 L3 65 

Reactive power -Rc (QII) ∑ Li 6 L1 26 L2 46 L3 66 

Reactive power -Ri (QIII) ∑ Li 7 L1 27 L2 47 L3 67 

Reactive power +Rc (Q IV) ∑ Li 8 L1 28 L2 48 L3 68 

Apparent power  +VA (QI +QIV) ∑ Li 9 L1 29 L2 49 L3 69 

Apparent power -VA (QII+QIII) ∑ Li 10 L1 30 L2 50 L3 70 

Current 2) 11  L1 31 L2 51 L3 71 

Voltage 2) 12 L1 32 L2 52 L3 72 

Power factor  ∑ Li 13 L1 33 L2 53 L3 73 

Supply frequency  14 L1 34 L2 54 L3 74 

Active power  |+A|+|-A|  15 L1 35 L2 55 L3 75 

Active power |+A|-|-A|  16 L1 36 L2 56 L3 76 

Active power +A (QI)  17 L1 37 L2 57 L3 77 

Active power -A (QII)  18 L1 38 L2 58 L3 78 

Active power -A (QIII)  19 L1 39 L2 59 L3 79 

Active power +A (QIV)  20 L1 40 L2 60 L3 80 

Phase angles  81   

Neutral current  91   

Neutral voltage  92   

Service entries 3)  96   

Error messages 3)  97   

List objects 3)  98   

Data profiles 3)  99   

 
1)  QI, QII, QIII, QIV = Quadrant 1, 2, 3, 4 

2)  any phase 

3)  In all data readouts the OBIS code is shown in .MAP tools in numeric format only (as 

defined in the standard) instead of partly using characters. Affected values: "C"=96, 

"F"=97, "L"=98 and "P"=99. This now allows a correct referencing to the standard. 
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The values 128 to 255 have manufacturer-specific definitions.  

Some examples of Landis+Gyr definitions are:  

 

Value Application 

130 Sum of all phases: reactive power quadrant I+IV+II+III 

131 Sum of all phases: reactive power quadrant I+II-III-IV 

132 Sum of all phases: reactive power quadrant I+IV 

133 Sum of all phases: reactive power quadrant II+III 

150 Phase 1: reactive power quadrant I+IV+II+III 

151 Phase 1: reactive power quadrant I+II-III-IV 

152 Phase 1: reactive power quadrant I+IV 

153 Phase 1: reactive power quadrant II+III 

170 Phase 2: reactive power quadrant I+IV+II+III 

171 Phase 2: reactive power quadrant I+II-III-IV 

172 Phase 2: reactive power quadrant I+IV 

173 Phase 2: reactive power quadrant II+III 

190 Phase 3: reactive power quadrant I+IV+II+III 

191 Phase 3: reactive power quadrant I+II-III-IV 

192 Phase 3: reactive power quadrant I+IV 

193 Phase 3: reactive power quadrant II+III 

 

Group D of the OBIS identification can have values in the range between 0 and 

255. The individual values are differently assigned depending on the value of 

group A and C, but are not described here. 

 

Group E of the OBIS identification can have values in the range between 0 and 

255. In the Landis+Gyr .MAP120 Parameter Editor for group E for electricity-

related items (group A = 1) the values corresponding to the number of tariffs 

specified mainly appear (0 = total of all tariffs, 1 = tariff 1, 2 = tariff 2, etc.). Other 

values apply for specific values of group C, but these are not described here.  

 

Group F of the OBIS identification can have values in the range between 0 and 

255. In the Landis+Gyr .MAP120 Parameter Editor group F is not used and is 

therefore always set to 255.  

10.2 Examples 

The following table shows a selection of OBIS identification numbers and explains 

their significance. 

 

OBIS code 

(decimal) 

OBIS code (hex) Description 

 A   B   C   D   E   F 

0-0:1.0.0 00  00  01  00  00  FF Clock 

0-0:42.0.0 00  00  2A  00  00  FF DLMS device identification 

0-0:96.1.0 00  00  60  01  00  FF Identification number 2.1 

0-0:96.1.1 00  00  60  01  01  FF Identification number 2.2 

Group D 

Group E 

Group F 
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OBIS code 

(decimal) 

OBIS code (hex) Description 

 A   B   C   D   E   F 

0-0:96.2.0 00  00  60  02  00  FF Number of parameterisations 

0-0:96.2.1 00  00  60  02  01  FF Date and time of last parameterisation 

0-0:96.2.2 00  00  60  02  02  FF Activation date TOU 

0-0:96.2.3 00  00  60  02  03  FF Date of last RCR program change 

0-0:96.240.0 00  00  60  F0  00  FF EEPROM identification 

0-0:96.240.13 00  00  60  F0  0D  FF Hardware ID 

0-0:96.3.1 00  00  60  03  01  FF Input terminal states base meter 

0-0:96.3.2 00  00  60  03  02  FF Output terminal states base meter 

0-0:96.4.0 00  00  60  04  00  FF Internal control signal states 

0-0:96.5.0 00  00  60  05  00  FF Internal operating state 

0-0:96.6.0 00  00  60  06  00  FF Operating time of battery 

0-0:96.6.3 00  00  60  06  03  FF Battery voltage 

0-0:96.7.0 00  00  60  07  00  FF Number of phase fails L1..L3 

0-0:96.7.1 00  00  60  07  01  FF Number of phase fails L1 

0-0:96.7.2 00  00  60  07  02  FF Number of phase fails L2 

0-0:96.7.3 00  00  60  07  03  FF Number of phase fails L3 

0-0:96.8.0 00  00  60  08  00  FF Total operating time 

0-0:96.8.t 00  00  60  08  t    FF Operating time (t = tariff number) 

0-0:96.90 00  00  60  5A  FF  FF Configuration ID 

0-0:96.90.1 00  00  60  5A  01  FF Physical IEC device address 

0-0:96.90.2 00  00  60  5A  02  FF Physical HDLC device address 

1-0:96.2.7 00  00  60  02  07  FF Activation date passive TOU 

0-0:97.97.0 00  00  61  61  00  FF Error code register 

0-0:98.1.0*126 00  00  62  01  00  7E Stored values 

0-0:240.1.0 00  00  F0  01  00  FF Device functions 

0-1:96.2.5 00  01  60  02  05  FF Date and time of last calibration 

0-1:96.240.8 00  01  60  F0  08  FF Hardware ID of base meter 

0-1:96.3.1 00  01  60  03  01  FF Input terminal states extension board 

0-1:96.3.2 00  01  60  03  02  FF Output terminal states extension board 

0-2:96.240.8 00  02  60  F0  08  FF Hardware ID of extension board 

0-2:96.240.9 00  02  60  F0  09  FF Reference hardware ID of extension 

board 

1-0:0.0.1 01  00  00  00  00  FF Identification number 1.1 

1-0:0.0.2 01  00  00  00  01  FF Identification number 1.2 

1-0:0.0.3 01  00  00  00  02  FF Identification number 1.3 

1-0:0.0.4 01  00  00  00  03  FF Identification number 1.4 

1-0:0.1.0 01  00  00  01  00  FF Reset counter 
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OBIS code 

(decimal) 

OBIS code (hex) Description 

 A   B   C   D   E   F 

1-0:0.1.2 01  00  00  01  02  FF Time and date of last billing period reset 

1-0:0.2.0 01  00  00  02  00  FF Software ID 

1-0:0.2.1 01  00  00  02  01  FF Parameterisation ID 

1-0:0.2.3 01  00  00  02  03  FF Ripple control receiver ID 

1-0:0.2.4 01  00  00  02  04  FF Connection ID 

1-0:0.2.7 01  00  00  02  07  FF Passive TOU ID 

1-0:0.9.5 01  00  00  09  05  FF Weekday 

1-0:96.99.8 01  00  60  69  08  FF Display and IEC readout ID 

1-0:99.1.0 01  00  63  01  00  FF Load profile 

1-0:99.98.0 01  00  63  62  00  FF Event log 

1-1:0.3.0 01  01  00  03  00  FF Meter constant active energy 

1-1:0.3.1 01  01  00  03  01  FF Meter constant reactive energy 

1-1:0.4.0 01  01  00  04  00  FF Scale factor for demand display 

1-1:0.4.1 01  01  00  04  01  FF Scale factor for energy display 

1-1:0.4.2 01  01  00  04  02  FF Current transformer ratio 

1-1:0.4.3 01  01  00  04  03  FF Voltage transformer ratio 

1-1:13.0.0 01  01  0D  00  00  FF Average billing period power factor 

1-1:13.3.n 01  01  0D  03  n   FF Power factor minimum (n = number) 

1-1:13.31.n 01  01  0D  23  n   FF Power factor threshold (n = number) 

1-1:13.35.n 01  01  0D  23  n   FF Power factor monitor threshold 

(n = number) 

1-1:13.5.0 01  01  0D  00  00  FF Last average power factor 

1-1:13.7.0 01  01  0D  07  00  FF Total power factor 

1-1:14.7.0 01  01  0E  07  00  FF Mains frequency 

1-1:31.7.0 01  01  1F  07  00  FF Current L1 

1-1:31.35.0 01  01  1F  23  00  FF Overcurrent threshold L1 

1-1:32.7.0 01  01  20  07  00  FF Voltage L1 

1-1:32.31.0 01  01  20  1F  00  FF Undervoltage threshold L1 

1-1:32.35.0 01  01  20  23  00  FF Overvoltage threshold L1 

1-1:33.7.0 01  01  21  07  00  FF Power factor L1 

1-1:51.7.0 01  01  33  07  00  FF Current L2 

1-1:51.35.0 01  01  33  23  00  FF Overcurrent threshold L2 

1-1:52.7.0 01  01  34  07  00  FF Voltage L2 

1-1:52.31.0 01  01  34  1F  00  FF Undervoltage threshold L2 

1-1:52.35.0 01  01  34  23  00  FF Overvoltage threshold L2 

1-1:53.7.0 01  01  35  07  00  FF Power Factor L2 

1-1:71.7.0 01  01  47  07  00  FF Current L3 

1-1:71.35.0 01  01  47  23  00  FF Overcurrent threshold L3 
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OBIS code 

(decimal) 

OBIS code (hex) Description 

 A   B   C   D   E   F 

1-1:72.7.0 01  01  48  07  00  FF Voltage L3 

1-1:72.31.0 01  01  48  1F  00  FF Undervoltage threshold L3 

1-1:72.35.0 01  01  48  23  00  FF Overvoltage threshold L3 

1-1:73.7.0 01  01  49  07  00  FF Power Factor L3 

1-1:81.7.0 01  01  51  07  00  FF Angle U(L1) to U(L1) 

1-1:81.7.1 01  01  51  07  01  FF Angle U(L2) to U(L1) 

1-1:81.7.2 01  01  51  07  02  FF Angle U(L3) to U(L1) 

1-1:81.7.3 01  01  51  07  04  FF Angle I(L1) to U(L1) 

1-1:81.7.4 01  01  51  07  05  FF Angle I(L2) to U(L1) 

1-1:81.7.5 01  01  51  07  06  FF Angle I(L3) to U(L1) 

1-1:91.7.0 01  01  5B  07  00  FF Neutral current 

1-1:91.35.0 01  01  5B  23  00  FF Overcurrent threshold N 

1-1:m.2.0 01  01  m   02  00  FF Cumulative maximum demand 

(m = measured quantity) 

1-1:m.4.0 01  01  m   04  00  FF Current average demand (m = measured 

quantity) 

1-1:m.6.t 01  01  m   06  t    FF Maximum demand register 

(m = measured quantity, t = tariff 

number) 

1-1:m.8.0 01  01  m   08  00  FF Total energy register (m = measured 

quantity) 

1-1:m.8.t 01  01  m   08  t    FF Energy register (cumulative) 

(m = measured quantity, t = tariff 

number) 

1-1:m.9.t 01  01  m   09  t    FF Energy register (billing period delta 

value) (m = measured quantity, t = tariff 

number) 

1-1:m.29.t 01  01  m   1D  t    FF Energy register (registration period delta 

value) (m = measured quantity, t = tariff 

number) 

1-1:m.35.n 01  01  m   23  n   FF Demand register monitor threshold 

(m = measured quantity, n = number) 

1-2:82.8.0 01  02  52  08  00  FF Counter S0 pulses input 1 

1-3:82.8.0 01  03  52  08  00  FF Counter S0 pulses input 2 

a-2:m.8.0 a    02  m   08  00  FF External pulse input 1 (a = medium, 

m = measured quantity) 

a-3:m.8.0 a    03  m   08  00  FF External pulse input 2 (a = medium, 

m = measured quantity) 
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11 List of abbreviations 

This section explains some abbreviations used in this user manual or on dialogue 

windows of the Landis+Gyr .MAP120 application in alphabetical order.  

 

Definition 

Description 

 

Distribution Line Message Specification  

Messaging system defined originally as part of the application layer of the proto-

col stack for distribution line carrier systems (IEC 61334-4-41, 1996). Its universal-

ity and its independence of the actual communication channel allowed DLMS to 

become the choice of the metering industry for any metering application (Device 

Language Message Specification). 

 

Energy Data Identification System   

Identification number system for clear identification of energy data according to 

DIN 43863-3:1997. 

 

Global System for Mobile communications  

Wireless communication network for data and voice transmission.  

 

High Level Data Link Control  

Communication protocol used by COSEM (IEC 62056-46), specifying the data link 

layer. The HDLC standard is ISO/IEC 13239, 2000 (second edition). Some older 

COSEM implementations rely on the first, 1996 edition of the standard.  

 

International Electrotechnical Commission  

IEC 62056-21 is the standard "Electricity metering - Data exchange for meter read-

ing, tariff and load control - Part 21: Direct local data exchange". This is the third 

edition of the formerly well-known standard IEC 61107 (IEC 1107). 

 

Meter Application Product  

The .MAP software tools have been developed and distributed by Landis+Gyr to 

support electricity meters. This group of tools comprises the .MAP 110 Parameter 

Editor and the .MAP120 Parameter Editor.  

 

Object Identification System  

Identification number system for clear identification of DLMS items. 

 

Public Switched Telephone Network   

The public switched telephone network can be used for data transmission. To this 

purpose a modem (modulator/demodulator) must be inserted between computer 

and telephone network and also between the telephone network and the remote 

device.  

 

Vereinigung Deutscher Elektrizitätswerke  

VDEW is the central organisation of the German electrical industry. It combines 

and represents the interests of its members and is consultant and forward-looking 

body for energy questions (refer also to www.strom.de). 

 

Abbreviation 

DLMS 

EDIS 

GSM 

HDLC 

IEC 

.MAP 

OBIS 

PSTN 

VDEW 
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12 Index 

.MAP ................................................................... 128 

Access authentication......................................... 118 

Access level ................................................... 59, 119 

Access levels ......................................................... 76 

Address book import ............................................ 93 

Address data ......................................................... 89 

Address toolbar .................................................... 18 

Addressing devices ................................................ 99 

Application of access levels ................................ 119 

Application toolbar ............................................... 17 

ASCII to Text conversion ..................................... 104 

Auxiliary functions .............................................. 104 

Basic principles for communication ..................... 58 

Changing 

the language of the user interface ................ 105 

Client toolbar ........................................................ 18 

Colour definition ................................................. 105 

Communication channel ................................... 7, 58 

Communication channel data .............................. 62 

Communication channel toolbar .......................... 19 

Communication examples .................................. 100 

Communication protocols ...................................... 8 

Communication settings ....................................... 60 

Communication solutions ................................... 103 

Comparing a device description to a file .............. 40 

Conditions for the use of this user manual ............ 6 

Conventions ............................................................ 6 

Copy communication log to clipboard ................. 26 

Current version of the program ......................... 115 

Defining 

colours ........................................................... 105 

compare layout ............................................... 34 

file locations .................................................. 107 

key management system .............................. 109 

lists ................................................................... 46 

print layout ...................................................... 33 

storage policy for keys and passwords .......... 108 

Defining IP addresses ........................................... 91 

Defining phone numbers ...................................... 89 

Delete communication log ................................... 26 

Device ................................................................... 59 

Device address ................................................ 75, 99 

Device data ........................................................... 73 

Device description window .................................. 19 

Device security system ....................................... 118 

Device toolbar ...................................................... 18 

Device type ........................................................... 74 

Direct connection ................................................. 58 

DLMS ................................................................... 128 

dlms application layer .......................................... 69 

dlms link layer ....................................................... 68 

EDIS ..................................................................... 128 

Editing parameters ................................................ 42 

Editions .................................................................... 8 

Entering license data ............................................. 13 

Establishing communication ................................. 99 

Ethernet connection ............................................ 102 

Examples of OBIS identification codes ................ 124 

Fields of application of .MAP tools.......................... 7 

File locations setting............................................ 107 

First installation ....................................................... 9 

Folder handling ..................................................... 21 

Full text search ................................................ 23, 27 

Functions of the .MAP120 ....................................... 7 

HDLC .................................................................... 128 

IEC 71, 128 

Import address book ............................................. 93 

Importing keys ....................................................... 81 

Improper data access .......................................... 118 

Installation ............................................................... 9 

Invalid parameter setting indication ..................... 48 

IP address definition .............................................. 91 

IP address selection ............................................... 18 

Key import ............................................................. 81 

Key management system .................................... 109 

Keys ..................................................................... 118 

LAN connection ................................................... 102 

Language versions ............................................... 105 

Licence data........................................................... 13 

License key entry ................................................... 13 

Licensing concept .................................................. 12 

Links between devices and communication 

channels ........................................................... 95 

Local connection ................................................... 58 

Local warnings ....................................................... 49 

Menu bar ............................................................... 16 

Message security ................................................. 119 

Modem connection ....................................... 59, 101 

Network connection .............................................. 59 

via a LAN ......................................................... 102 

via a WLAN and the Internet .......................... 103 

OBIS identification codes .................................... 122 

Object identification system OBIS ....................... 122 

Offline key import ................................................. 81 

Online help .......................................................... 113 

Online key import .................................................. 84 

Opening communication log ................................. 26 

Page setup ....................................................... 33, 34 

Parameter 

Local warnings .................................................. 49 

Parameter overwriting protection ...................... 118 

Parameterisation wizard ....................................... 50 
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start ................................................................. 51 

Parameterising 

all parameters except security system ............ 52 

device security system..................................... 56 

time of use ....................................................... 55 

Parameters 

define lists ....................................................... 46 

edit ................................................................... 42 

enter values ..................................................... 42 

select options .................................................. 44 

select values .................................................... 44 

Using special functions .................................... 47 

Passwords ........................................................... 118 

Phone number definition ..................................... 89 

Phone number selection....................................... 18 

Physical device address ......................................... 99 

Physical layer ........................................................ 65 

Previewing the printout on the screen ................. 36 

Print 

device definitions ............................................ 35 

layout definition .............................................. 33 

preview ............................................................ 36 

Problem solving .................................................. 117 

Program version ................................................. 115 

PSTN .................................................................... 128 

Purpose of this user manual ................................... 6 

Reading device description from a device ............ 39 

Reading head ........................................................ 58 

Read-me file ........................................................ 114 

Reference documents ......................................... 103 

Release notes ..................................................... 114 

Saving communication log ................................... 26 

Saving device definitions ....................................... 31 

under a new name .......................................... 32 

Screen areas ......................................................... 15 

Search function ...............................................23, 27 

Security attributes .............................................. 118 

Security switches ................................................ 118 

Security system .................................................. 118 

Serial connection 

via the optical interface ................................ 100 

Status bar ........................................................27, 38 

Storage policy for keys and passwords .............. 108 

Support ............................................................... 117 

Supported devices .................................................. 8 

Switching the saving prompt on and off ............ 106 

System requirements ............................................. 9 

Target group of this user manual ........................... 6 

Text to ASCII conversion ..................................... 104 

Tool help ............................................................. 113 

Tree items ............................................................. 21 

Tree view .............................................................. 20 

Uninstallation ....................................................... 10 

Update check ...................................................... 115 

Upgrades ................................................................ 9 

User groups ............................................................ 8 

User interface ....................................................... 15 

VDEW .................................................................. 128 

Warnings .............................................................. 49 

Wizard .................................................................. 50 
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